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CALIBRATION PROCEDURE

NI 5450
This document describes processes to calibrate the National 

Instruments PXIe-5450 (NI 5450) differential I/Q signal generator. 

This document provides performance tests to verify if the instrument is 

performing within the published specifications. For more information 

about calibration, visit ni.com/calibration.
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Conventions

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

This icon denotes a note, which alerts you to important information.

bold Bold text denotes items that you must select or click in the software, such 

as menu items and dialog box options. Bold text also denotes parameter 

names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 

to a key concept. Italic text also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames, and extensions.
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Software Requirements

Calibrating the NI 5450 requires installing NI-FGEN version 2.6 or later on 

the calibration system. You can download the NI-FGEN instrument driver 

from the Instrument Driver Network Web site at ni.com/idnet. 

NI-FGEN supports programming a self-calibration and an external 

calibration in the LabVIEW, LabWindows™/CVI™, and C or C++ 

application development environments (ADEs). When you install 

NI-FGEN, you only need to install support for the ADE that you intend 

to use.

LabVIEW support is in the niFgen.llb file, and all calibration functions 

appear in the NI-FGEN Calibration palette. For LabWindows/CVI users, 

the NI-FGEN function panel (niFgen.fp) provides access to the available 

functions.

For the locations of files you may need to calibrate your device, refer to 

the NI-FGEN Instrument Driver Readme, which is available on the 

NI-FGEN CD.

Note After you install NI-FGEN, you can access the NI-FGEN Instrument Driver Readme 

and other signal generators documentation at Start»All Programs»

National Instruments»NI-FGEN»Documentation.

Documentation Requirements

For information about NI-FGEN and the NI 5450, refer to the following 

documents:

• NI Signal Generators Getting Started Guide—provides instructions for 

installing and configuring NI signal generators.

• NI Signal Generators Help—includes detailed information about 

the NI 5450 and the NI-FGEN VIs and functions.

These documents are installed with NI-FGEN. You also can find the latest 

versions of the documentation at ni.com/manuals.

NI recommends referring to the following document online at ni.com/

manuals to ensure you are using the latest NI 5450 specifications:

• NI 5450 Specifications—provides the published specification values 

for the NI 5450.

Note If you are using NI-FGEN 2.6, the NI 5450 Specifications are not installed. You must 

download the specifications at ni.com/manuals.
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Password

The default password for password-protected operations is NI. This 

password is required to open an external calibration session.

Calibration Interval

A calibration is required once a year; however, the measurement accuracy 

demands of your application determine how often external calibration 

should be performed.

Test Equipment

Table 1 lists the equipment required to calibrate the NI 5450. If you do not 

have the recommended equipment, select a substitute calibration standard 

using the specifications listed in Table 1.

Table 1.  Equipment Required for Calibrating the NI 5450

Calibration 

Procedure

Required 

Equipment

Recommended 

Instruments

Minimum 

Specifications

DC Amplitude 

Accuracy,

DC Amplitude AC 

Amplitude 

Channel-to-Channel 

Relative Accuracy,

Differential Offset,

Common Mode 

Offset,

AC Amplitude 

Accuracy,

Channel-to-Channel 

Relative Accuracy,

DC ADC and 

Reference 

Adjustment*

Digital multimeter 

(DMM)

NI PXI-4071 DCV accuracy: 

≤ 0.05%

DCV input impedance: 

≥ 1 GΩ

ACV accuracy: 

≤  0.13%

ACV input impedance: 

≥ 10 MΩ

Bandwidth: ≥ 100 kHz
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Channel-to-Channel 

Timing Alignment 

Accuracy,

Rise/Fall Time†,

Aberrations†

Digital oscilloscope 

(DPO)

Tektronix DPO70404 Analog bandwidth: 

≥ 4 GHz (–3 dB)

Real-time sample rate: 

25 GS/s

Jitter noise floor: 

≤ 450 fs

Differential probe Tektronix 

P7380SMA

Differential rise time: 

(10% to 90%): ≤ 55 ps

Differential-mode input 

resistance: 100 Ω 

Differential bandwidth: 

≥ 4 GHz (–3 dB)

Frequency Response 

(Flatness) Accuracy,

Channel-to-Channel 

Frequency Response 

(Flatness) Matching 

Accuracy,

Frequency Response 

(Flatness) 

Adjustment*

Power meter/sensor 

(x2)‡

Rohde & Schwarz 

(R&S) NRP-Z91

VSWR: (50 kHz to

120 MHz) ≤ 1.11

Relative power 

accuracy: ≤ 0.022 dB

Fixed 7 dB SMA 

attenuator (x2)

Mini-Circuits 

VAT-7-1+

VSWR (50 kHz to 

120 MHz): 1.02:1

Flatness (50 kHz to

60 MHz): 0.05 dB

Flatness (60 MHz to 

120 MHz): 0.07 dB

Semi-rigid coaxial 

cable (X2)‡, **

Anritsu 

K120MF-5CM

2 in (m)(f) 50 Ω ±2 Ω 

Attenuation ≤ 1.6 dB/m 

at 1 GHz

Flatness (50 kHz to

120 MHz): 0.001 dB 

50 Ω SMA 

termination‡, **

Anritsu 28K50(m) 50 Ω ±1%

Table 1.  Equipment Required for Calibrating the NI 5450 (Continued)

Calibration 

Procedure

Required 

Equipment

Recommended 

Instruments

Minimum 

Specifications
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Average Noise 

Density,

Internal Reference 

Clock Frequency 

Accuracy,

Spurious free 

dynamic range with 

harmonics†,

Spurious free 

dynamic range 

without harmonics†,

Total harmonic 

distortion (THD)†,

Intermodulation 

distortion (IMD3)†

Spectrum analyzer R&S FSU26 

#SN20 and above 

with improved phase 

noise

• FSU-B23 20 dB 

preamplifier

• FSU-B25 

electronic 

attenuator

Frequency accuracy 

≤ 100 Hz

Specifications for the 

following parameters 

must be better than or 

equal to the equipment 

recommended for 

f ≤ 200 MHz:

• Total level 

measurement 

uncertainty

• Displayed average 

noise level

SSB phase noise 

(1 Hz)

• Intermodulation 

Distortion

• Total harmonic 

distortion

• Spurious free 

dynamic range

• Reference frequency

• RF input VSWR

Output Phase Noise†,

Output Jitter†

Phase noise analyzer R&S FSUP SSB phase noise (1 Hz) 

at the offset frequencies 

must be at least 3 dB 

better than the NI 5450 

specification.

Table 1.  Equipment Required for Calibrating the NI 5450 (Continued)

Calibration 

Procedure

Required 

Equipment

Recommended 

Instruments

Minimum 

Specifications
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Average Noise 

Density,

Internal Reference 

Clock Frequency 

Accuracy,

Spurious free 

dynamic range with 

harmonics†,

Spurious free 

dynamic range 

without harmonics†,

Total harmonic 

distortion (THD)†,

Intermodulation 

distortion (IMD3)†,

Output Phase Noise†,

Output Jitter†

BALUN Picosecond 5320B BW ≥ 500 MHz

Impedance: 50 Ω 

(100 Ω differential)

Differential balance 

≤ 0.2 dB

Return loss > 20 dB

Rise time < 500 ps

— SMA torque wrench — Coupling torque: 

56 N–cm (5 in/lb)

— SMA 50 Ω high 

quality cables (x4)

— 1 ft. maximum length

Matching length 

≤± 1 ps at 200 MHz

* Adjustment Test

† Optional Test

‡ The procedure can be performed using a single power meter.

** If you are using a single power meter, load the unused terminal with the 7 dB attenuator and the 50 Ω termination to 

balance the output that does not have a power meter attached. If you are using two power meters throughout the procedure, 

the 50 Ω SMA termination is not required.

Table 1.  Equipment Required for Calibrating the NI 5450 (Continued)

Calibration 

Procedure

Required 

Equipment

Recommended 

Instruments

Minimum 

Specifications
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Test Conditions

Follow these guidelines to optimize the connections and the environment 

during calibration:

• Keep connections to the NI 5450 short. Long cables and wires act as 

antennae, picking up noise that can affect measurements.

• Keep the NI 5450 outputs balanced at all times during measurements.

• Keep relative humidity between 10% and 90% noncondensing.

• Maintain a temperature between 18 °C and 28 °C.

• Allow a warm-up time of at least 30 minutes after powering on all 

hardware, loading the operating system, and, if necessary, enabling the 

device. Unless manually disabled, the NI-FGEN driver automatically 

loads with the operating system and enables the device. The warm-up 

time brings the measurement circuitry of the NI 5450 to a stable 

operating temperature.

• Perform self-calibration on the device. Do not perform self-calibration 

until the device has completed the 30-minute warm up.

• Ensure that the PXI Express chassis fan speed is set to HI, that the fan 

filters are clean, and that the empty slots contain filler panels.

• Plug the PXI Express chassis and the calibrator into the same power 

strip to avoid ground loops.

Calibration Procedures

The calibration process includes the following steps:

1. Initial Setup—Install the device and configure it in Measurement & 

Automation Explorer (MAX).

2. Self-Calibration—Adjust the self-calibration constants of the device.

3. Verification—Verify the existing operation of the device. This step 

confirms whether the device is operating within its specified range 

prior to adjustment.

4. Adjustment—Perform an external adjustment of the device that adjusts 

the calibration constants of the device. The adjustment procedure 

automatically stores the calibration date on the EEPROM to allow 

traceability.

5. Reverification—Repeat the verification procedure to ensure that the 

device is operating within its specifications after adjustment.

These procedures are described in more detail in the following sections.
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Initial Setup
Refer to the NI Signal Generators Getting Started Guide for information 

about how to install the software and hardware and how to configure the 

device in MAX.

Self-Calibration
The NI 5450 is capable of performing self-calibration, which adjusts the 

gain of the direct path and channel-to-channel timing alignment. An 

onboard, 24-bit ADC and precision voltage reference are used to calibrate 

the DC gain. Onboard channel alignment circuitry is used to calibrate the 

skew between channels. Appropriate constants are stored in nonvolatile 

memory, along with the self-calibration date and time.

Note Common mode offset is minimized through active circuitry and is not adjusted in 

self-calibration. Differential offset is not adjusted during self-calibration.

Self-calibration can be initiated from MAX, FGEN Soft Front Panel, or 

programmatically using NI-FGEN.

External Calibration
External calibration involves both verification and adjustment. Verification 

is the process of testing the device to ensure that the output accuracy is 

within certain specifications. You can use verification to ensure that the 

adjustment process was successful.

Adjustment is the process of measuring and compensating for device 

performance to improve the output accuracy. Performing an adjustment 

updates the calibration date, resetting the calibration interval. The device is 

warranted to meet or exceed its published specifications for the duration of 

the calibration interval. 

This document provides two sets of test limits for adjustable specifications, 

the As Found Test Limit and the After Adjustment Test Limit. Both sets of 

test limits include the Measurement Uncertainty. The After Adjustment test 

limits are more restrictive than the As Found test limits because they do not 

include errors that result from the long-term drift of the instrument. If all of 

the output errors determined during verification fall within the After 

Adjustment test limits, the device is warranted to meet or exceed its 

published specifications for a full calibration interval (one year). For this 

reason, you must verify against the After Adjustment test limits when 

performing verification after adjustment. Use the As Found Test Limit 

during initial verification.
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Measurement Uncertainty
Measurement uncertainty was calculated in accordance with the method 

described in ISO GUM (Guide to the Expression of Uncertainty in 

Measurement), for a confidence level of 95%. 

The expressed uncertainty is based on the recommended measurement 

methodology, standards, metrology best practices and environmental 

conditions of the National Instruments laboratory. It should be considered 

as a guideline for the level of measurement uncertainty that can be achieved 

using the recommended method. It is not a replacement for the user 

uncertainty analysis that takes into consideration the conditions and 

practices of the individual user.

Verification
This section provides instructions for verifying the NI 5450 specifications. 

Refer to Table 1 for recommendations about choosing an instrument for 

each test.

Required verification tests the following NI 5450 specifications:

• DC amplitude absolute accuracy

• Differential offset

• Common mode offset

• DC amplitude channel-to-channel relative accuracy

• AC amplitude absolute accuracy

• AC amplitude channel-to-channel relative accuracy

• Channel-to-channel timing alignment accuracy

• Frequency response (flatness) accuracy

• Average noise density

• Internal reference clock frequency accuracy

Optional verification tests the following NI 5450 specifications:

• Channel-to-channel frequency response (flatness) matching accuracy

• Analog bandwidth

• Spurious free dynamic range (SFDR) with harmonics

• Spurious free dynamic range without harmonics

• Total harmonic distortion (THD)

• Intermodulation distortion (IMD3)

• Output phase noise

• Output jitter
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• Rise/fall time

• Aberrations

Verification of the NI 5450 is complete only after you have successfully 

completed all required tests in this section.

Refer to Figure 1 for the names and locations of the NI PXIe-5450 front 

panel connectors. You can find information about the functions of these 

connectors in the NI Signal Generators Getting Started Guide.

Figure 1.  NI PXIe-5450 Front Panel
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Verifying DC Voltage Amplitude Absolute Accuracy
Complete the following steps to verify the DC voltage amplitude absolute 

accuracy of an NI 5450 module using a digital multimeter (DMM).

1. Connect the DMM to the CH 0 output terminals of the NI 5450 as 

shown in Figure 2.

Note The channel signal is connected differentially to the DMM. Signal grounds can be 

connected together if necessary, but should remain floating.

Figure 2.  DC Voltage Amplitude Absolute Accuracy Verification 
Connections for the NI 5450

1 NI PXIe-5450 2 NI PXI-4071

HI

LO

AUX

I/O

300V
MAX

5V
MAX

AMPS

NI PXI-4071

500V MAX

CAT I

HI

LO

1kV
MAX

3A, 250V
MAX

INPUT 1kV
MAX

7
1/

2-Digit FlexDMM

HI

LO

AUX

I/O

300V
MAX

5V
MAX

AMPS

NI PXI-4071

500V MAX

CAT I

HI

LO

1kV
MAX

3A, 250V
MAX

INPUT 1kV
MAX

7

7
1/

2-Digit FlexDMM

1 1

2 2

CH 0 CH 1
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2. Configure the DMM according to Table 2 for the appropriate NI 5450 

output voltage from Table 3.

3. Configure the NI 5450 for the appropriate configuration in Table 3.

Note Refer to the Measurement Uncertainty section for more information about the 

measurement uncertainty calculations in Table 3.

Table 2.  Calibration Equipment Configuration for DC Amplitude Absolute Accuracy Verification

NI 5450 DMM

Configuration CH Output (V) Function

Range 

(V)*

Input 

Impedance 

(GΩ)* Average Readings

1 0, 1 +0.1, –0.1 DC Voltage 0.1 10 4

2 0, 1 +1.0, –1.0

+0.5, –0.5

DC Voltage 1 10 4

* Assumes an NI 4071 DMM. For other DMMs, use the range closest to the values listed in this table. The input impedance should be

equal to or greater than the values indicated in Table 1.
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Table 3.  NI 5450 Output Parameters Configuration and Test Limits for DC Amplitude Absolute Accuracy Verification

Config. CH

Differential 

Output Range

(Vpk-pk) Gain Error*

Load 

Impedance 

(GΩ)

Waveform 

Data 

Amplitude

(V)

As Found 

Test Limit

(V)

After 

Adjustment Test 

Limit

(V)

Measurement 

Uncertainty

(µV)

1 0 2 1 ε=VDMM–

VExpected

10 +0.1 ± 0.004 ± 0.0018 ± 4

2 10 +0.5 ± 0.004 ± 0.0018 ± 15

3 10 +1.0 ± 0.004 ± 0.0018 ± 40

4 10 –0.1 ± 0.004 ± 0.0018 ± 4

5 10 –0.5 ± 0.004 ± 0.0018 ± 15

6 10 –1.0 ± 0.004 ± 0.0018 ± 40

7 1 10 +0.1 ± 0.004 ± 0.0018 ± 4

8 10 +0.5 ± 0.004 ± 0.0018 ± 15

9 10 +1.0 ± 0.004 ± 0.0018 ± 40

10 10 –0.1 ± 0.004 ± 0.0018 ± 4

11 10 –0.5 ± 0.004 ± 0.0018 ± 15

12 10 –1.0 ± 0.004 ± 0.0018 ± 40

* Expected is equal to the waveform data amplitude multiplied by gain.
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4. Wait 5 seconds for the equipment to settle.

5. Measure the output voltage with the DMM.

6. Record the measurement and calculate the output error.

7. Compare the output error to the test limit for the appropriate 

configuration in Table 3.

8. Repeat steps 2 through 7 for each configuration in Table 3 for CH 0.

9. Set the output voltage level to 0.

10. Connect the DMM to the NI 5450 as shown in Figure 2 for CH 1.

11. Repeat steps 2 through 7 for each configuration in Table 3 for CH 1.

12. Set the output voltage level to 0.

Verifying DC Voltage Differential Offset Accuracy
Complete the following steps to verify the DC voltage differential offset 

accuracy of an NI 5450 module using a digital multimeter (DMM).

1. Connect the DMM to the CH 0 output terminals of the NI 5450 as 

shown in Figure 2 for CH 0.

2. Configure the DMM with the following characteristics:

• Function: DC voltage

• Range: 0.1 V

• Input impedance: 10 GΩ

• Average reading: 4

Note These values assume you are using an NI 4071 DMM. For other DMMs, use the 

range closest to the values listed. The input impedance should be equal to or greater than 

the values indicated in Table 1.

3. Configure the NI 5450 to generate a waveform with the following 

characteristics:

• Waveform data amplitude: 0 V

• Load impedance: 10 GΩ

• Gain: 1

• Channel: CH 0, CH 1

4. Wait 5 seconds for the equipment to settle.

5. Measure the output voltage using the DMM.

6. Record the measurement and compare it to the test limit in Table 4.
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Note Refer to the Measurement Uncertainty section for more information about the 

measurement uncertainty calculations in the following table.

7. Connect the DMM to the CH 1 output terminals of the NI 5450 as 

shown in Figure 2 for CH 1.

8. Repeat steps 3 through 6 for CH 1.

Verifying DC Voltage Common Mode Offset Accuracy
Complete the following steps to verify the DC voltage common mode 

offset accuracy of an NI 5450 module using a digital multimeter.

1. Connect the NI 5450 CH 0+ output to the positive output of the DMM 

and the cable shield ground of the NI 5450 CH 0+ output to the 

negative input of the DMM as shown in Figure 3.

Figure 3.  DC Voltage Common Mode Offset Accuracy Verification Connection (CH 0)

Table 4.  NI 5450 Output Parameters Configuration and Test Limits
for DC Voltage Differential Offset Accuracy Verification

Config. CH

Differential 

Output 

Range

(Vpk-pk) Gain

Load 

Impedance 

(GΩ)

Waveform 

Data 

Amplitude

(V)

As 

Found 

Test 

Limit

(mV)

After 

Adjustment 

Test Limit

(mV)

Measurement 

Uncertainty

(µV)

1 0 2 1 10 +0.0 ± 1.0 ± 0.75 ± 3.0

2 1 2 1 10 +0.0 ± 1.0 ± 0.75 ± 3.0

1 NI PXIe-5450 2 Dual banana plug 3 NI PXI-4071

HI

LO

AUX

I/O

300V
MAX

5V
MAX

AMPS

NI PXI-4071

500V MAX

CAT I

HI

LO

1kV
MAX

3A, 250V
MAX

INPUT 1kV
MAX

/7
1

-Digit FlexDMM2

1 3

2
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2. Configure the DMM with the following characteristics:

• Function: DC voltage

• Range: 0.1 V

• Input impedance: 10 GΩ

• Average reading: 4

Note These values assume you are using an NI 4071 DMM. For other DMMs, use the 

range closest to the values listed. The input impedance should be equal to or greater than 

the values indicated in Table 1.

3. Set up the NI 5450 according to Table 5.

Note Refer to the Measurement Uncertainty section for more information on the 

measurement uncertainty calculation in the following table.

4. Wait 5 seconds for the equipment to settle.

5. Measure the output voltage using the DMM and record the 

measurement as VCMO(+).

Table 5.  NI 5450 Output Parameters Configuration and Test Limits for DC Voltage Common Mode Offset Accuracy

CH

Load 

Imped-

ance 

(GΩ)

Waveform 

Data 

Amplitude

(V) Gain

Error 

(V)

As 

Found 

Test 

Limit

(µV)

After 

Adjust-

ment Test 

Limit

(µV)

Measurement 

Uncertainty

(µV)

0, 1 10 0.0 V 1 ±350 ±250 ±1.3
εVCMO

VCMO +( ) VCMO -( )+( )

2
----------------------------------------------------=
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6. Connect the NI 5450 CH 0- output to the positive output of the DMM 

and the cable shield ground of the NI 5450 CH 0- output to the negative 

input of the DMM as shown in Figure 4.

Figure 4.  DC Voltage Common Mode Offset Accuracy Verification Connection (CH 0)

7. Wait 5 seconds for the equipment to settle.

8. Measure the output voltage using the DMM and record the 

measurement as VCMO(-).

9. Calculate the error using the equation in Table 5 and compare it to the 

test limit.

1 NI PXIe-5450 2 Dual banana plug 3 NI PXI-4071

HI

LO

AUX

I/O

300V
MAX

5V
MAX

AMPS

NI PXI-4071

500V MAX

CAT I

HI

LO

1kV
MAX

3A, 250V
MAX

INPUT 1kV
MAX

/7
1

-Digit FlexDMM2

1

2

3
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10. Repeat steps 1 through 9, replacing CH 0 with CH 1. The connections 

are shown in Figure 5.

Figure 5.  DC Voltage Common Mode Offset Accuracy Verification Connections (CH 1)

1 NI PXIe-5450 2 Dual banana plug 3 NI PXI-4071

/7
1

-Digit FlexDMM2
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LO

AUX

I/O

300V
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5V
MAX

AMPS

NI PXI-4071

500V MAX
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LO

1kV
MAX

3A, 250V
MAX

INPUT 1kV
MAX

HI

LO

AUX

I/O

300V
MAX

5V
MAX

AMPS

NI PXI-4071

500V MAX

CAT I

HI

LO

1kV
MAX

3A, 250V
MAX

INPUT 1kV
MAX

/7
1

-Digit FlexDMM2

1

2

2
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Verifying DC Voltage Channel-to-Channel Relative 
Accuracy
Using the values recorded in step 6 of the Verifying DC Voltage Amplitude 

Absolute Accuracy section, calculate the DC voltage channel-to-channel 

relative accuracy for each configuration in Table 6. 

Note The values are calculated using the measurements recorded in Table 3.

Note Refer to the Measurement Uncertainty section for more information on the 

measurement uncertainty calculations in the following table.

Verifying AC Voltage Amplitude Absolute Accuracy
Complete the following steps to verify the AC voltage amplitude absolute 

accuracy of an NI 5450 module using a digital multimeter (DMM).

1. Connect the DMM to the NI 5450 as shown in Figure 2 for CH 0.

2. Configure the NI 5450 to generate a waveform with the following 

characteristics:

• Waveform: Sine wave

• Frequency: 50 kHz 

• Sample rate: 400 MS/s

• Waveform data amplitude: 1 Vpk (2 Vpk–pk)

• Load impedance: 10 MΩ

• Gain: 1

• Channel: CH 0, CH 1

Table 6.  DC Amplitude Channel-to-Channel Relative Accuracy Verification

Configuration CH

Waveform 

Data 

Amplitude

(V)

Error 

(V)

Test Limit

(µV)

Measurement 

Uncertainty

(µV)

1 0, 1 +0.1 ±1600 ±20

2 0, 1 +0.5 ±1600 ±20

3 0, 1 +1.0 ±1600 ±20

4 0, 1 –0.1 ±1600 ±20

5 0, 1 –0.5 ±1600 ±20

6 0, 1 –1.0 ±1600 ±20

ε0,1 VCH0 VCH1–=
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3. Configure the DMM with the following characteristics:

• Function: AC voltage

• Range: 5 V

• Input impedance: 10 MΩ

• Average reading: 4

Note These values assume you are using an NI 4071 DMM. For other DMMs, use the 

range closest to the values listed. The input impedance should be equal to or greater than 

the values indicated in Table 1.

4. Configure the NI 5450 for the appropriate configuration in Table 7.

Note Refer to the Measurement Uncertainty section for more information on the 

measurement uncertainty calculations in Table 7.
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Table 7.  NI 5450 Output Parameters Configuration and Test Limits for AC Amplitude Accuracy Verification

Config. CH Gain

Waveform 

Data 

Amplitude

Differential 

Output 

Range Error (%)

As Found 

Test Limit

(%)

After 

Adjustment 

Test Limit

(%)

Measurement 

Uncertainty 

(%)

1 0 1 50 kHz 

(full scale*, 

sine wave)

2 Vpk–pk ± 0.5 ± 0.2 ± 0.13

2 1 1 50 kHz 

(full scale*, 

sine wave)

± 0.5 ± 0.2 ± 0.13

* Full scale for waveform data amplitude is ±1.

ε 2 VRMS× 1–( ) 100×=
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5. Wait 15 seconds for the output of the NI 5450 to settle.

6. Measure the output voltage amplitude with the DMM.

7. Record the VRMS measurement.

8. Calculate the peak-to-peak amplitude error using the equation in 

Table 7.

9. Compare the output error to the test limit for the appropriate 

configuration in Table 7.

10. Set the output voltage level to 0.

11. Connect the DMM to the NI 5450 as shown in Figure 2 for CH 1.

12. Repeat steps 2 through 10 for Configuration 2 of Table 7 for CH 1.

Verifying AC Amplitude Channel-to-Channel Relative 
Accuracy
Complete the following steps to verify the AC amplitude 

channel-to-channel relative accuracy of an NI 5450 module.

1. Use the values recorded in step 7 of the Verifying AC Voltage 

Amplitude Absolute Accuracy section to calculate the AC amplitude 

channel-to-channel relative accuracy using the equation in Table 8.

Note Refer to the Measurement Uncertainty section for more information on the 

measurement uncertainty calculations in the following table.

2. Compare the output error to the Test Limit in Table 8.

Table 8.  AC Amplitude Channel-to-Channel Relative Accuracy Verification

CH Gain

Differential 

Output Range

(Vpk–pk)

Error

(mVpk–pk)

 Test Limit 

(mVpk–pk)

Measurement 

Uncertainty

(mVpk–pk)

0, 1 1 2.0 ±4.0 ±0.2ε0,1 2 2 VRMSCH0
VRMSCH1

–( )××=
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Verifying Channel-to-Channel Timing Alignment 
Accuracy
Complete the following steps to verify the channel-to-channel timing 

alignment accuracy of an NI 5450 module using a digital oscilloscope and 

a differential acquisition probe.

1. Connect the devices as shown in Figure 6.

Figure 6.  NI 5450 Connection to an Oscilloscope Using

a Differential Acquisition Probe (CH 0)

Note Use the cables that are included with the oscilloscope for the connections to the 

NI 5450. When changing the connections from CH 0 to CH 1 in step 14, maintain the same 

relative cable position.

2. Configure the NI 5450 to generate a waveform with the following 

characteristics:

• Waveform: Square wave

• Frequency: 10 MHz 

• Sample rate: 400 MS/s

• Waveform data amplitude: 0 dBFS

• Gain setting: 0.5

1 NI 5450 Signal Generator
2 Tektronix P7380SMA Differential Probe

3 Tektronix DPO70404 Digital Oscilloscope

2

CH1
CH2

3

1
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• Load impedance: 50 Ω

• Output channel: CH 0, CH 1 (simultaneous)

• Exported sample clock timebase divisor: 40

• Sample clock timebase export location: Clkout

Note Both NI 5450 channels must be enabled simultaneously during this test. If the 

session is disabled or restarted at any point during the test, the measurements are invalid.

Configure the oscilloscope according to the following steps:

3. Run DEFAULT SETUP to set the oscilloscope to a known state.

4. Enable CH 1 and CH 2 on the oscilloscope.

5. Run AUTOSET to acquire CH 1 and CH 2 waveforms.

6. Set the oscilloscope to trigger continuously on the rising edge of CH 1.

7. Set the acquisition mode to average 256 samples.

8. Center the rising edge of the CH 2 waveform in the center of the 

oscilloscope display by using HORIZONTAL DELAY.

9. Adjust the oscilloscope vertical scale of CH 2 to maximum while 

keeping the waveform within the display, approximately 125 mV/div.

10. Set the timebase to 1 ns/div and use HORIZONTAL DELAY to keep 

the CH 2 rising edge centered in the oscilloscope display.

11. Set the scale resolution to 1 ps/pt.

12. Clear the acquisition averages and then wait for 256 acquisitions to 

occur.

13. Save the CH 2 waveform as REF1 (NI 5450, CH 0).
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14. Connect the devices as shown in Figure 7.

Figure 7.  NI 5450 Connection to an Oscilloscope Using

a Differential Acquisition Probe (CH 1)

15. Clear the waveform averages.

16. The rising edge of the NI 5450 CH 1 output waveform should now be 

in the center of the oscilloscope display.

17. Recall the CH 2 output waveform previously saved as REF1 (NI 5450, 

CH 0) in step 13.

18. Set the oscilloscope to measure the delay between REF1 (NI 5450, 

CH 0) and the current CH 2 input (NI 5450, CH 1). The measurement 

should be rising to rising edge at 50% amplitude.

19. Wait for the measurement counter to reach at least 50 before the 

reading is made.

20. Measure and record the mean value.

1 NI 5450 Signal Generator
2 Tektronix P7380SMA Differential Probe

3 Tektronix DPO70404 Digital Oscilloscope

CH1
CH2

2

3

1
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21. Compare the delay value with the Test Limit in Table 9.

Verifying Frequency Response (Flatness)
Complete the following steps to verify the frequency response (flatness) of 

an NI 5450 module using a power meter(s) and 7 dB attenuators.

Note The frequency response (flatness) verification can be performed using a single 

power meter. If you are using a single power meter, load the unused terminal with the 7 dB 

attenuator and the 50 Ω termination.

Table 9.  Channel-to-Channel Timing Alignment Accuracy Verification

CH*

Output 

Frequency

Channel-to-Channel Timing 

Alignment (ps) Test Limit

Measurement 

Uncertainty

0, 1 10 MHz ≤ 35 ps 5.3 ps

* Both NI 5450 channels must be enabled simultaneously during this test. If the session is disabled or restarted at any point 

during the test, the measurements are invalid.

talignment tCH2 tCH1–=
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1. Connect the devices as shown in Figure 8, using semi-rigid coaxial 

cables to connect the power meters simultaneously if needed.

Figure 8.  NI 5450 Connection to Power Meters Using Attenuators (CH 0)

2. Disable the NI 5450 outputs.

3. Null the power meter(s) according to the power meter documentation.

4. Configure the power meter(s) with the following characteristics:

• Multichannel 

• Average: 16

• Measure watts

• Channel 1 power sensor connected to the NI 5450(+)

• Channel 2 power sensor connected to the NI 5450(–)

• High accuracy

1 NI 5450 Signal Generator
2 Mini-Circuits VAT-7-1+ Attenuator
3 Anritsu K120MF-5CM semi-rigid coaxial cable

4 N-Type to SMA adapter
5 Rohde & Schwarz NRP-Z91 Power Meter

2

1
3

5

4



© National Instruments Corporation 29 NI 5450 Calibration Procedure

5. Configure the NI 5450 according to Configuration 1 in Table 10.

6. Configure the NI 5450 and power meter frequency according to 

Configuration 1 in Table 11, the reference frequency.

Table 10.  NI 5450 Setup for Frequency Response (Flatness) Verification

Config. CH Function

Waveform 

Amplitude Gain

Flatness 

Correction

Waveform 

Sample 

Differential 

Load*

1 0, 1 Sine wave 0 dBFS 0.4 Enable 400 MS/s 100 Ω

2 0, 1 Sine wave –20 dBFS 0.4 Enable 400 MS/s 100 Ω

* The NI-FGEN software load impedance is single-ended. Therefore, setting the load impedance to 50 Ω in NI-FGEN is 

equal to 100 Ω differential.
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Table 11.   Frequency Response (Flatness) Verification

Config. CH Frequency Frequency Response (Flatness)∗
As Found 

Test Limit

After 

Adjustment 

Test Limit

Measurement 

Uncertainty

1 0, 1 50 kHz Reference Reference —

2 0, 1 10 kHz ±0.24 dB ±0.22 dB 0.10 dB

3 0, 1 100 kHz ±0.24 dB ±0.22 dB 0.10 dB

4 0, 1 1 MHz ±0.24 dB ±0.22 dB 0.10 dB

5 0, 1 10 MHz ±0.24 dB ±0.22 dB 0.10 dB

6 0, 1 20 MHz ±0.24 dB ±0.22 dB 0.10 dB

7 0, 1 30 MHz ±0.24 dB ±0.22 dB 0.10 dB

8 0, 1 40 MHz ±0.24 dB ±0.22 dB 0.10 dB

9 0, 1 50 MHz ±0.24 dB ±0.22 dB 0.10 dB

10 0, 1 60 MHz ±0.24 dB ±0.22 dB 0.10 dB

11 0, 1 70 MHz ±0.34 dB ±0.25 dB 0.12 dB

12 0, 1 80 MHz ±0.34 dB ±0.25 dB 0.12 dB

13 0, 1 90 MHz ±0.34 dB ±0.25 dB 0.12 dB

14 0, 1 100 MHz ±0.34 dB ±0.25 dB 0.12 dB

15 0, 1 110 MHz ±0.34 dB ±0.25 dB 0.12 dB

16 0, 1 120 MHz ±0.34 dB ±0.25 dB 0.12 dB

∗ This equation converts the power meter readings in watts to voltage to add the differential amplitudes in volts, and then converts the result to dB.

FlatnessRef 10
Wf +( ) W+

f -( )
2 Wf +( ) Wf -( )

××+

WRef +( ) W+
Ref -( )

2 WRef +( )
WRef -( )

××+
-------------------------------------------------------------------------------------------------------log×=
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7. Allow the power meter to stabilize for 10 seconds.

8. Measure and record the reference (50 kHz) power (WRef(+) [W]) of the 

positive output.

9. Measure and record the reference (50 kHz) power (WRef(–) [W]) of the 

negative output.

10. Configure the NI 5450 and power meter frequency according to the 

next configuration in Table 11.

11. Allow the power meter to stabilize for 10 seconds.

12. Measure and record the power at the set frequency (Wf(+) [W]) of the 

positive output.

13. Measure and record the power at the set frequency (Wf(–) [W]) of the 

negative output.

14. Using the recorded power values, calculate the deviation from the 

reference (50 kHz) power using the equation in Table 11.

15. Compare the Frequency Response (Flatness) to the test limit for the 

appropriate configuration in Table 11.

16. Repeat steps 10 through 15 for each configuration in Table 11.

17. Configure the NI 5450 according to Configuration 2 in Table 10.

18. Repeat steps 7 through 16.
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19. Connect the devices as shown in Figure 9, using semi-rigid coaxial 

cables to connect the power meters simultaneously if needed.

.

Figure 9.  NI 5450 Connection to Power Meters Using Attenuators (CH 1)

20. Repeat steps 5 through 18.

1 NI 5450 Signal Generator
2 Mini-Circuits VAT-7-1+ Attenuator
3 Anritsu K120MF-5CM semi-rigid coaxial cable

4 N-Type to SMA adapter
5 Rohde & Schwarz NRP-Z91 Power Meter

2

1

3

5

4
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Verifying Average Noise Density
Complete the following steps to verify the average noise density of an 

NI 5450 module using a spectrum analyzer and BALUN.

1. Connect the devices as shown in Figure 10.

Figure 10.  NI 5450 Connection to Spectrum Analyzer Using a BALUN (CH 0)

Note Use high quality 50 Ω SMA cables of the same electrical length. Keep the cables as 

short as possible for all connections.

2. Configure the NI 5450 to generate a waveform with the following 

characteristics:

• Waveform: sine wave

• Frequency: 1 MHz 

• Sample rate: 400 MS/s

• Waveform data amplitude: –40 dBFS

• Gain setting: 0.5

• Load impedance: 50 Ω (100 Ω differential)

• Output channel: CH 0

1 NI 5450 signal generator
2 Matched length cables

3 Picosecond 5320B BALUN
4 R&S FSU26 spectrum analyzer

5 RF IN connector

+

–

1

2

3

4

5
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3. Set the spectrum analyzer to its default and configure it with the 

following characteristics:

• Measurement: Noise marker on

• Preamplifier: On

• Detector: RMS

• Frequency range: 9 kHz to 200 MHz

• Reference level: –40 dBm

• Attenuation: 0 dB

• Resolution bandwidth: 500 kHz

• Video bandwidth: 2 MHz

• Sweep time: 1 s

Note Refer to the Measurement Uncertainty section for more information on the 

measurement uncertainty calculations in the following table.

4. Set the marker frequency to 10 MHz.

5. Measure and record the noise density as displayed on MARKER1.

Note The marker should return the noise level in dBm/Hz.

6. With the focus on MARKER1 and using a step of 10 MHz, enter the 

new frequency.

7. Measure and record the noise density as displayed on MARKER1.

8. Repeat steps 5 through 7 until the frequency reaches 200 MHz.

9. Using the recorded power values, calculate the average noise density 

using the equation in Table 12.

10. Compare the Average Noise Density with the Test Limit in Table 12.

Table 12.  Average Noise Density Verification

CH

Output 

Frequency

Average Noise Density

(dBm/Hz)

Test Limit

(dBm/Hz)

Measurement 

Uncertainty

(dB)

0, 1 0–200 MHz

Frequency step = 10 MHz, 
from 10 MHz to 200 MHz

≤ –160 0.60

AVG_ND 20
10

log×
Σ

n
i 1= 10

NoiseDensity i( )

20
-------------------------------------------- 

n
-----------------------------------------------------------











=
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11. Connect the devices as shown in Figure 11.

Figure 11.  NI 5450 Connection to Spectrum Analyzer Using a BALUN (CH 1)

12. Repeat steps 4 through 10.

Verifying Internal Reference Clock Frequency 
Accuracy
Complete the following steps to verify the internal reference clock 

frequency accuracy of an NI 5450 module using a spectrum analyzer and 

BALUN.

1. Connect the devices as shown in Figure 10.

2. Verify that the NI 5450 is not locked to an external clock and is using 

the onboard clock.

3. Configure the NI 5450 to generate a waveform with the following 

characteristics:

• Waveform: Sine wave

• Frequency: 10 MHz 

• Sample rate: 400 MS/s

1 NI 5450 signal generator
2 Matched length cables

3 Picosecond 5320B balun
4 R&S FSU26 spectrum analyzer

5 RF IN connector

+

–

1

2

3

4

5
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• Waveform data amplitude: 0.0 dBFS

• Gain setting: 0.5

• Load impedance: 50 Ω (100 Ω differential)

• Output channel: CH 0

4. Set the spectrum analyzer to its default and configure it with the 

following characteristics:

• Frequency: 10 MHz

• Span: 1 MHz

• Reference level: 0 dBm

• Measurement counter: 1 Hz

• Signal count: Enabled

5. Measure and record the frequency (fmeas) as displayed on 

MARKER1.

6. Compare the frequency measured with the test limit in Table 13.

Note Refer to the Measurement Uncertainty section for more information on the 

measurement uncertainty calculations in the following table.

Optional Verification Tests

Verifying Channel-to-Channel Frequency Response 
(Flatness) Matching Accuracy
Complete the following steps to verify the channel-to-channel frequency 

response (flatness) matching accuracy of an NI 5450 module.

1. Use the values calculated in the Verifying Frequency Response 

(Flatness) section to calculate the channel-to-channel frequency 

response (flatness) matching accuracy.

Table 13.   Internal Reference Clock Accuracy Verification

CH Frequency Error (%) As Found Test Limit

Measurement 

Uncertainty

0 10 MHz ± 0.01% 0.33 µHz/Hz

ε
fmeas 10M–

10 M
----------------------------- 100×=
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Table 14.  Channel-to-Channel Frequency Response (Flatness) Matching Accuracy Verification

Config. CH Frequency Error (dB)

Test Limit

(dB), 

typical

1 0 to 1 10 kHz ε(CH0 – CH1) = FlatnessCH0(f) – FlatnessCH1(f) ±0.03

2 0 to 1 100 kHz ±0.03

3 0 to 1 1 MHz ±0.03

4 0 to 1 10 MHz ±0.03

5 0 to 1 20 MHz ±0.03

6 0 to 1 30 MHz ±0.03

7 0 to 1 40 MHz ±0.03

8 0 to 1 50 MHz ±0.03

9 0 to 1 60 MHz ±0.03

10 0 to 1 70 MHz ±0.04

11 0 to 1 80 MHz ±0.04

12 0 to 1 90 MHz ±0.04

13 0 to 1 100 MHz ±0.04

14 0 to 1 110 MHz ±0.04

15 0 to 1 120 MHz ±0.04
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Verifying Analog Bandwidth
Complete the following steps to verify the analog bandwidth of an NI 5450 

module using a power meter(s).

Note The analog bandwidth verification can be performed using a single power meter. 

If you are using a single power meter, load the unused terminal with the 7 dB attenuator 

and the 50 Ω termination.

1. Connect the devices as shown in Figure 8, using semi-rigid coaxial 

cables to connect the power meters simultaneously if needed.

2. Configure the power meter(s) with the following characteristics:

• Multichannel 

• Average: 16

• Measure watts

• High accuracy

3. Disable the NI 5450 output and null the power meter(s) according to 

the power meter documentation.

4. Configure the NI 5450 with the following characteristics:

• Waveform: Sine wave

• Sample rate: 400 MS/s

• Waveform data amplitude: 0 dBFS

• Gain setting: 0.5

• Load impedance: 50 Ω (100 Ω differential)

• Flatness correction: Disabled

• Output channel: CH 0 and CH 1

5. Configure the NI 5450 and power meter frequency according to 

Configuration 1 in Table 15, the reference frequency.

Table 15.  Analog Bandwidth Verification

Config. CH Frequency Frequency Response∗
Test Limit 

(dB), typical

1 0, 1 50 kHz Reference —

2 0, 1 130 MHz ≥ –2.25 dB

3 0, 1 140 MHz ≥ –2.75 dB

4 0, 1 145 MHz ≥ –3 dB

∗ This equation converts the power meter readings from watts to voltage to add the differential amplitudes in volts and then 

converts the result to dB.

FlatnessRef 10
Wf +( ) W+

f -( )
2 Wf +( ) Wf -( )

××+

WRef +( ) W+
Ref -( )

2 WRef +( )
WRef -( )

××+
-------------------------------------------------------------------------------------------------------log×=
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6. Allow the power meter to stabilize for 10 seconds.

7. Measure and record the reference power (WRef(+) [W]) of the positive 

output.

8. Measure and record the reference power (WRef(–) [W]) of the negative 

output.

9. Configure the NI 5450 and power meter frequency according to the 

next configuration in Table 15.

10. Measure and record the power at the set frequency (Wf(+) [W]) of the 

positive output.

11. Measure and record the power at the set frequency (Wf(–) [W]) of the 

negative output.

12. Using the recorded power values, calculate the deviation from the 

reference power at 50 kHz using the equation in Table 15.

13. Compare the frequency response (flatness) to the Test Limit for the 

appropriate configuration in Table 15.

14. Repeat steps 9 through 13 for each configuration in Table 15.

Verifying Spurious Free Dynamic Range with and 
without Harmonics
Complete the following steps to verify the spurious free dynamic range 

(SFDR) with harmonics of an NI 5450 module using a spectrum analyzer 

and BALUN.

1. Configure the NI 5450 to generate a waveform with the following 

characteristics:

• Waveform: Sine wave

• Frequency: 10 MHz 

• Sample rate: 400 MS/s

• Waveform data amplitude: –1 dBFS

• Gain setting: 0.5

• Load impedance: 50 Ω (100 Ω differential)

• Output channel: CH 0 and CH 1

2. Set the spectrum analyzer to its default and configure it with the 

following characteristics:

• Frequency range: 9 kHz to 210 MHz

• Attenuation: 30 dB

• Reference level: 0 dBm

• Detector mode: Max peak

• Resolution bandwidth: 5 kHz
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• Video bandwidth: 20 kHz

• Averaging: On

• Sweep count: 10

3. Connect the devices as shown in Figure 10.

4. Place MARKER1 at the carrier frequency and set it as a fixed 

reference.

5. Turn on MARKER2 as a delta marker.

6. Wait until the spectrum analyzer has reached sweep count.

7. Move MARKER2 to the highest peak within the 200 MHz range.

8. Measure and record the SFDR (with harmonics) as displayed by the 

delta marker.

Note The marker should return the measurement in dBc.

Table 16.  Spurious Free Dynamic Range Accuracy Verification

Config. CH

Carrier 

Frequency

(MHz)

Spurious Free Dynamic Range

(dB)

Test Limit

(dB), typical

1 0, 1 10 SFDRWith Harmonics =

Ampl(carrier) – Ampl(LargestSpur)

≥70

2 0, 1 10 SFDRWithout Harmonics =

Ampl(carrier) – Ampl(Non-harmonic LargestSpur)

≥70

3 0, 1 60 SFDRWith Harmonics =

Ampl(carrier) – Ampl(LargestSpur)

≥68

4 0, 1 60 SFDRWithout Harmonics =

Ampl(carrier) – Ampl(Non-harmonic LargestSpur)

≥68

5 0, 1 100 SFDRWith Harmonics =

Ampl(carrier) – Ampl(LargestSpur)

≥62

6 0, 1 100 SFDRWithout Harmonics =

Ampl(carrier) – Ampl(Non-harmonic LargestSpur)

≥64

7 0, 1 120 SFDRWith Harmonics =

Ampl(carrier) – Ampl(LargestSpur)

≥62

8 0, 1 120 SFDRWithout Harmonics =

Ampl(carrier) – Ampl(Non-harmonic LargestSpur)

≥62

9 0, 1 160 SFDRWith Harmonics =

Ampl(carrier) – Ampl(LargestSpur)

≥62

10 0, 1 160 SFDRWithout Harmonics =

Ampl(carrier) – Ampl(Non-harmonic LargestSpur)

≥62
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9. Compare the SFDR (with harmonics) with the Test Limit in Table 16 

for the carrier frequency.

10. Move Marker2 to the highest peak that is a non-harmonic of the carrier.

Note Aliased harmonics are considered non-harmonics. Harmonics are only integer 

multiples of the carrier frequency.

11. Measure and record the SFDR (without harmonics) as displayed on 

delta marker.

12. Compare the SFDR (without harmonics) with the Test Limit in 

Table 16 for the carrier frequency.

13. Change the NI 5450 output frequency (carrier) to the next Test in 

Table 16 and repeat steps 4 through 12.

14. Reset the average.

15. Repeat steps 4 through 14 for all carrier frequencies in Table 16.

16. Connect the devices as shown in Figure 11.

17. Repeat steps 4 through 15 for CH 1.

Verifying Total Harmonic Distortion
Complete the following steps to verify the total harmonic distortion (THD) 

of an NI 5450 module using a spectrum analyzer and BALUN.

1. Connect the devices as shown in Figure 10.

2. Configure the NI 5450 to generate a waveform with the following 

characteristics:

• Waveform: Sine wave

• Frequency: 10.1 MHz 

• Sample rate: 400 MS/s

• Waveform data amplitude: –1 dBFS

• Gain setting: 0.5

• Load impedance: 50 Ω (100 Ω differential)

• Output channel: CH 0 and CH 1

3. Set the spectrum analyzer to its default and configure it with the 

following characteristics:

• Frequency range: 10.1 MHz

• Reference level: 0 dBm

• Attenuation: 35 dB

• Detector mode: Max peak
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• Span: 100 kHz

• Resolution bandwidth: 2 kHz

• Video bandwidth: 5 kHz

• Average: On

• Sweep: 20

4. Enable the HARMONIC DISTORTION measurement function.

5. Wait until the spectrum analyzer has acquired all sweeps to average.

6. Set the NO. OF HARMONICS to 6.

7. De-select the HARMONIC RBW AUTO function.

8. To further try to optimize the measurement, go to AMPT menu and 

change the RF ATTENUATION to minimize the spectrum analyzer 

distortion on the THD reading.

Note Incorrect attenuation on the spectrum analyzer can severely affect the THD 

measurement. Refer to the spectrum analyzer documentation for more information.

9. Record the THD value.

10. Disable the HARMONIC measure function.

11. Change the NI 5450 output frequency and the spectrum analyzer center 

frequency to the next Carrier Frequency value in Table 17.

12. Repeat steps 4 through 11 for all the carrier frequencies in Table 17.

13. Connect the devices as shown in Figure 11.

14. Repeat steps 4 through 12 for CH 1.

Table 17.  Total Harmonic Distortion Accuracy Verification

Configuration CH

Carrier 

Frequency

(MHz)

Test Limit

(dBc), typical

1 0, 1 10.1 ≤–75

2 0, 1 20.1 ≤–70

3 0, 1 40.1 ≤–68

4 0, 1 80.1 ≤–68

5 0, 1 100.1 ≤–68

6 0, 1 120.1 ≤–78

7 0, 1 160.1 ≤–83
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Verifying Intermodulation Distortion (IMD3)
Complete the following steps to verify the intermodulation distortion of an 

NI 5450 module using a spectrum analyzer and BALUN.

1. Connect the devices as shown in Figure 10.

2. Configure the NI 5450 to generate a waveform with the following 

characteristics:

• Waveform:

– Tone Frequency 1: 9.9 MHz 

– Tone Frequency 2: 10.1 MHz

• Sample rate: 400 MS/s

• Waveform data amplitude (each tone): –7 dBFS

• Gain Setting: 0.5

• Load Impedance: 50 Ω (100 Ω differential)

• Output channel: CH 0

3. Configure the spectrum analyzer with the following characteristics:

• Frequency range: 10 MHz

• Reference level: –6 dBm

• RF attenuation: 20 dB

• Detector mode: Max peak

• Span: 700 kHz

• Resolution bandwidth: 5 kHz

• Video bandwidth: 20 kHz

• Average: On

• Sweep: 50

Table 18.  Intermodulation Distortion (IMD3) Verification Setup

Config. CH

Tone 1 

Frequency 

(MHz)

Tone 2 

Frequency 

(MHz)

Center 

Frequency

(MHz)

IMD3

(dBc)

Test 

Limit 

(dBc), 

typical

1 0, 1 9.9 10.1 10 ≤ –84

2 0, 1 19.9 20.1 20 ≤ –81

3 0, 1 39.9 40.1 40 ≤ –75

4 0, 1 59.9 60.1 60 ≤ –71

5 0, 1 79.9 80.1 80 ≤ –68

6 0, 1 119.9 120.1 120 ≤ –68

7 0, 1 159.9 160.1 160 ≤ –66

Max P 2 f2 f1–×  P 2 f1 f2–× ( , ) Min Pf1
Pf2

( , )–
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4. Enable the TOI function.

5. To further try to optimize the measurement, go to the AMPT menu and 

change the RF ATTENUATION to minimize the spectrum analyzer 

distortion on the IMD3 (TOI) reading.

Note Incorrect attenuation on the spectrum analyzer can severely affect the IMD3 

measurement. Refer to the spectrum analyzer documentation for more information.

6. Measure and record the value of the following:

• Amplitude of Carrier Tone 1

• Amplitude of Carrier tone 2

• Amplitude of 3rd order harmonic product 1, 2f2–f1

• Amplitude of 3rd order harmonic product 2, 2f1–f2

7. Use the equation in Table 18 to calculate the IMD3.

8. Change the NI 5450 output frequency to the next carrier tone 

frequencies as indicated in Table 18.

9. Change the spectrum analyzer CENTER FREQUENCY to the 

adequate value indicated in Table 18.

10. Repeat steps 4 through 9 for all carrier frequencies in Table 18.
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Verifying Rise and Fall Time
Complete the following steps to verify the rise time and fall time of an 

NI 5450 module using an oscilloscope.

1. Connect the devices as shown in Figure 12.

Figure 12.  NI 5450 Connection to the Oscilloscope (CH 0 and CH 1)

Note Keep the cables as short as possible for all connections.

2. Configure the NI 5450 to generate a waveform with the following 

characteristics:

• Waveform: Square wave

• Frequency: 33 MHz 

• Sample rate: 400 MS/s

• Waveform data amplitude: 1 Vpk (2 Vpk–pk)

• Gain setting: 0.5

1 NI PXIe-5450 2 Tektronix DPO70404 Oscilloscope

2

1

CH1
CH2

CH3
CH4
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• Load impedance: 50 Ω

• Output channel: CH 0, CH 1

• Flatness correction: Disabled

3. Configure the oscilloscope according to the following steps:

a. Press the DEFAULT SETUP to reset the oscilloscope to a known 

state.

b. Enable oscilloscope channels 1 through 4.

c. Press AUTOSET to acquire the waveform

d. Configure the oscilloscope as follows:

• CH 1 to CH 4 amplitude: 70 mV/div

• CH 1 to CH 4 termination: 50 Ω

• Acquisition Mode: Average

• Acquisition # of Wfms: 64

• Horizontal Scale: 4 ns/div

Four complete waveform periods, one for each channel, should be 

centered on the display.

4. Configure the oscilloscope measurements as follows:

• CH1 Time function: Rise Time (10% to 90%)

• CH1 Time function: Fall Time (10% to 90%)

5. Wait for the measurement counter to reach at least 50 before making 

the reading.

6. Read and record the CH1 RISE mean as the Rise Time measurement. 

7. Read and record the CH1 FALL mean as the Fall Time measurement.

8. Repeat steps 4 through 7, configuring the measurements for 

channels 2, 3, and 4. 

Table 19.  Rise and Fall Time Verification

Test CH Specification Test Limit, typical

1 0+, 0–, 1+, 1– Rise Time (10% to 90%) ≤ 3 ns

2 0+, 0–, 1+, 1– Fall Time (10% to 90%) ≤ 3 ns
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Verifying Aberrations
Complete the following steps to verify the aberrations of an NI 5450 

module using an oscilloscope.

1. Connect the devices as shown in Figure 12.

2. Configure the NI 5450 to generate a waveform with the following 

characteristics:

• Waveform: Trapezoidal

• Slew rate: 133 V/µs

• Frequency: 10 MHz

• Sample rate: 400 MS/s

• Waveform data amplitude: 1 Vpk (2 Vpk–pk)

• Gain setting: 0.5

• Load impedance: 50 Ω

• Output channel: CH 0, CH 1

• Flatness correction: Disabled

Note To limit the slew rate to 133 V/µs, create a trapezoidal waveform with enough edge 

points at specific amplitudes to achieve the required rate of voltage change during the 

transitions. Create a linear array with 40 points: –1, –1, –1, –1, –1, –1, –1, –1, –1, –1, –1, 

–1, –1, –1, –1, –1, –1, –1, –0.33, +0.33, +1, +1, +1, +1, +1, +1,+1, +1, +1, +1, +1, +1, +1, 

+1, +1, +1, +1, +1, +0.33, –0.33. This array totals 40 points with a 2.5 ns interval between 

them to generate a 10 MHz waveform frequency (0.1 µs period). Repeat this waveform ten 

times to have enough points to meet the minimum waveform size by concatenating the one 

period array within the loop ten times.

3. Configure the oscilloscope according to the following steps:

a. Press the DEFAULT SETUP to reset the oscilloscope to the 

original manufacturing state.

b. Enable oscilloscope channels 1 through 4.

c. Press AUTOSET to acquire the waveform

d. Configure the oscilloscope as follows:

• CH 1 to CH 4 amplitude: 70 mV/div

• CH 1 to CH 4 termination: 50 Ω

• Acquisition Mode: Average

• Acquisition # of Wfms: 64

• Horizontal Scale: 10 ns/div

One complete waveform period should be displayed for each 

output terminal.
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4. Configure the oscilloscope measurements as follows:

• CH 1 Amplitude: Positive Overshoot

• CH 1 Amplitude: Negative Overshoot

5. Wait for the measurement counter to reach at least 64 before making 

the reading.

6. Read and record the channel 1 positive overshoot mean as the rising 

edge aberration measurement.

7. Read and record the channel 1 negative overshoot mean as the falling 

edge aberration measurement.

8. Repeat steps 4 through 7, configuring the measurements for 

channels 2, 3, and 4.

Verifying Phase Noise Density and Jitter
Complete the following steps to verify the phase noise density and jitter of 

an NI 5450 using a phase noise analyzer and BALUN.

1. Set the phase noise analyzer to its default and configure it with the 

following characteristics:

• Measurement mode: Phase noise

• Center frequency: 10 MHz

• Level: 0 dBm

• Spot noise offset frequencies: Refer to Table 21

• Sweep mode: Normal

• Frequency span: 100 Hz to 1 MHz

Table 20.  Aberration Time Verification

Test CH Specification

Test Limit, 

typical

1 0+, 0–, 1+, 1– Rising Edge Aberration ≤ 7%

2 0+, 0–, 1+, 1– Falling Edge Aberration ≤ 7%
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Phase Noise Measurements (CH 0, 10 MHz)

1. Connect the devices as shown in Figure 13.

Figure 13.  NI 5450 Connection to Phase Noise Analyzer using a BALUN (CH 0)

Note Use high quality 50 Ω SMA cables of the same electrical length. Keep the cables as 

short as possible for all connections.

Table 21.  Offset Frequency Field Settings for Spot Noise

Offset Freq Field Set to Frequency

Offset Freq1 100 Hz

Offset Freq2 1 kHz

Offset Freq3 10 kHz

Offset Freq4 100 kHz

Offset Freq5 1 MHz

1 NI PXIe-5450
2 Picosecond 5320B BALUN

3 R&S FSUP Phase Noise Analyzer
4 RF IN Connector

+

–

4

1

2

3
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2. Configure the NI 5450 according to configuration 1 in Table 22 and 

enable output.

3. Take a new phase noise measurement.

4. Record the 10 MHz output “Spot Noise” readings.

5. Compare the readings to the appropriate Output Frequency in 

Table 24.

Jitter Measurements (CH 0, 10 MHz)

1. Set the phase noise analyzer start frequency to 100 Hz.

2. Set the phase noise analyzer span stop frequency to 100 kHz.

3. Take a new phase noise measurement.

4. Record the CH 0, 100 MHz RMS jitter reading.

5. Compare the readings to the appropriate Output Frequency in 

Table 23.

Phase Noise Density Measurements (CH 0, 100 MHz)

1. Configure the NI 5450 according to configuration 2 in Table 22.

2. Set the phase noise analyzer center frequency to 100 MHz.

3. Set the phase noise analyzer span stop frequency to 1 MHz.

4. Take a new phase noise measurement.

5. Record the 100 MHz output “Spot Noise” readings.

6. Compare the readings to the appropriate Output Frequency in 

Table 24.

Table 22.  NI 5450 Setup for Phase Noise Density Verification

Config. CH Function

Waveform 

Data

Amplitude

Output 

Frequency

Waveform 

Sample 

Rate

Reference 

Clock Gain

Differential 

Load*

1 0 Sine 

wave

0 dBFS 10 MHz 400 MS/s Internal 0.5 100 Ω

2 0 Sine 

wave

0 dBFS 100 MHz 400 MS/s Internal 0.5 100 Ω

3 1 Sine 

wave

0 dBFS 100 MHz 400 MS/s Internal 0.5 100 Ω

4 1 Sine 

wave

0 dBFS 10 MHz 400 MS/s Internal 0.5 100 Ω

* The NI-FGEN software load impedance is single ended. Therefore, setting the load impedance to 50 Ω in NI-FGEN is 

equal to 100 Ω differential.
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Jitter Measurements (CH 0, 100 MHz)

1. Set the phase noise analyzer start frequency to 100 Hz.

2. Set the phase noise analyzer span stop frequency to 100 kHz.

3. Take a new phase noise measurement.

4. Record the CH 0, 100 MHz RMS jitter reading.

5. Compare the readings to the appropriate Output Frequency in 

Table 23.

Phase Noise Density Measurements (CH 1, 100 MHz)

1. Connect the devices as shown in Figure 14.

Figure 14.  NI 5450 Connection to a Phase Noise Analyzer Using a BALUN (CH 1)

Note Use high quality 50 Ω SMA cables of the same electrical length. Keep the cables as 

short as possible for all connections.

2. Configure the NI 5450 according to configuration 3 in Table 22.

3. Set the phase noise analyzer span stop frequency to 1 MHz.

4. Take a new phase noise measurement.

1 NI PXIe-5450
2 Picosecond 5320B BALUN

3 R&S FSUP Phase Noise Analyzer
4 RF IN Connector

+

–

1

2

3

4
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5. Record the 100 MHz output “Spot Noise” readings.

6. Compare the readings to the appropriate Output Frequency in 

Table 24.

Jitter Measurements (CH 1, 100 MHz)

1. Set the phase noise analyzer start frequency to 100 Hz.

2. Set the phase noise analyzer span stop frequency to 100 kHz.

3. Take a new phase noise measurement.

4. Record the CH 1, 100 MHz RMS jitter reading.

5. Compare the readings to the appropriate Output Frequency in 

Table 23.

Phase Noise Density Measurements (CH 1, 10 MHz)

1. Configure the NI 5450 according to configuration 4 of Table 22.

2. Set the phase noise analyzer center frequency to 10 MHz.

3. Set the phase noise analyzer span stop frequency to 1 MHz.

4. Take a new phase noise measurement.

5. Record the 10 MHz output “Spot Noise” readings.

6. Compare the readings to the appropriate Output Frequency in 

Table 24.

Jitter Measurements (CH 1, 10 MHz)

1. Set the phase noise analyzer start frequency to 100 Hz.

2. Set the phase noise analyzer span stop frequency to 100 kHz.

3. Take a new phase noise measurement.

4. Record the CH 1, 100 MHz RMS jitter reading.

5. Compare the readings to the appropriate Output Frequency in 

Table 23.

Table 23.  Jitter Accuracy Verification

CH Output Frequency Integrated Jitter*

0, 1 10 MHz < 350 fs

0, 1 100 MHz < 350 fs

* Jitter is integrated from 100 Hz to 100 kHz, using the internal reference clock.
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Adjustment
An adjustment is required only once per year. Following the adjustment 

procedure automatically updates the calibration date and temperature in the 

EEPROM of the NI 5450.

Adjustment corrects the following NI 5450 specifications:

• DC ADC and reference adjustment 

• Frequency response (flatness) adjustment

After adjustment, run self-calibration and then repeat the verification 

section to confirm that the adjustment was successful.

NI recommends that you always complete a full calibration to renew the 

calibration date and temperature. However, you can renew the calibration 

date and onboard calibration temperature without making any adjustments 

by completing the following steps.

Table 24.  Phase Noise Density Accuracy Verification

CH

Output 

Frequency Spot Noise 100 Hz 1 kHz 10 kHz 100 kHz 1 MHz

0, 1 10 MHz Test Limit, 

typical 

(dBc/Hz)

<–121 <–137 <–146 <–152 <–153

0, 1 100 MHz Test Limit, 

typical 

(dBc/Hz)

<–101 <–119 <–126 <–136 <–141
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1. Open an NI-FGEN external calibration session by calling the niFgen 

Init Ext Cal VI.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_InitExtCal using the 

following parameters:

resourceName: The name of the device 

you want to calibrate. This name can be 

found under Devices and Interfaces in 

MAX.

password: The password required to 

open an external calibration session. 

The default password is “NI”.

vi: A pointer to an IVI session. The 

variable passed by reference through 

this parameter receives the value that 

identifies the external calibration 

session created by this function. This 

value acts as the session handle and is 

passed as the first parameter to all 

subsequent NI-FGEN functions.
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2. Close the instrument driver session and save the calibration date and 

temperature by calling the niFgen Close Ext Cal VI.

Adjusting the DC ADC Reference
Complete the following steps to adjust the DC ADC reference using a 

digital multimeter (DMM).

Note Allow the NI 5450 and support equipment to warm up for a minimum of 30 minutes 

prior to performing an adjustment.

1. Connect the NI 5450 connector to the DMM as shown in Figure 2 for 

CH 0. Only CH 0 is used in this adjustment.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_CloseExtCal using the 

following parameters:

vi: The session handle returned 

from niFgen_InitExtCal 

action: If the external adjustment 

procedure completed without any errors, 

use NIFGEN_VAL_EXT_CAL_COMMIT. This 

function stores any new calibration 

constants, updated calibration dates, and 

updated calibration temperatures in the 

onboard EEPROM.

If any errors occurred during the external 

adjustment procedure, or if you want to 

abort the operation, use 

NIFGEN_VAL_EXT_CAL_ABORT. This 

function then discards the new calibration 

constants and does not change any 

of the calibration data stored in the onboard 

EEPROM.
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2. Configure the DMM according to Configuration 1 in Table 25.

3. Open an NI-FGEN external calibration session by calling the niFgen 

Init Ext Cal VI.

4. Call the niFgen Initialize Cal ADC Calibration VI.

Table 25.  Calibration Equipment Configuration for DC Amplitude Accuracy Adjustment

Configuration Function Range* Resolution† Average Readings

1 DC Voltage 0.1 V 7.5 digits 10

2 DC Voltage 1 V 7.5 digits 10

* Assumes an NI 4071 DMM. For other DMMs, use the range closest to the values listed in this table. The input impedance should be equal 

to or greater than the values indicated in Table 1.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_Init

ExtCal using the following 

parameters:

resourceName: The name of the device 

you want to calibrate. This name can be 

found under Devices and Interfaces in 

MAX.

password: The password required to 

open an external calibration session. 

The default password is “NI”

vi: A pointer to an IVI session. The 

variable passed by reference through 

this parameter receives the value that 

identifies the external calibration 

session created by this function. This 

value acts as the session handle and is 

passed as the first parameter to all 

subsequent NI-FGEN functions.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_InitializeCalADC

Calibration using the following 

parameter:

vi: The session handle returned 

from niFgen_InitExtCal 
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5. Set the gain DAC value by calling the niFgen Property Node and 

selecting Instrument»Calibration»Gain DAC Value.

6. Set the calibration ADC input by calling the niFgen Property Node and 

selecting Instrument»Calibration»Cal ADC Input.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_SetAttribute

ViInt32 using the following 

parameters:

vi: The session handle returned 

from niFgen_InitExtCal

channelName: NULL

attributeID: 

NIFGEN_ATTR_GAIN_DAC_

VALUE

value: 60948

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_SetAttribute

ViInt32 using the following 

parameters:

vi: The session handle returned 

from niFgen_InitExtCal

channelName: NULL

attributeID: 

NIFGEN_ATTR_CAL_ADC_INPUT

value: 

NIFGEN_VAL_ANALOG_OUTPUT_

PLUS
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7. Set the output impedance by calling the niFgen Property Node and 

selecting Output»Load Impedance. 

8. Set the main DAC value by calling the niFgen Write Binary 16 Analog 

Static Value VI.

9. Wait 1,000 ms for the output to settle.

10. Set the main DAC value by calling the niFgen Write Binary 16 Analog 

Static Value VI.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_SetAttribute

ViReal64 using the following 

parameters:

vi: The session handle returned 

from niFgen_InitExtCal

channelName: NULL

attributeId: 

NIFGEN_ATTR_LOAD_

IMPEDANCE

value: 1 GΩ

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_WriteBinary16

AnalogStaticValue using the 

following parameters:

vi: The session handle returned from 

niFgen_InitExtCal

channelName: NULL

value: 0

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_WriteBinary16

AnalogStaticValue using the 

following parameters:

vi: The session handle returned from 

niFgen_InitExtCal

channelName: NULL

value: 3113
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11. Disable the analog output by calling the niFgen Property Node and 

selecting Output»Output Enabled. 

12. Commit the attribute values to the device by calling the niFgen 

Commit VI.

Note Do not insert any additional settling time between steps 12 and 13.

13. Measure the analog output voltage with the onboard calibration ADC 

by calling the niFgen Read CAL ADC VI. 

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_SetAttribute

ViBoolean using the following 

parameters:

vi: The session handle returned 

from niFgen_InitExtCal

channelName: NULL

attributeId: 

NIFGEN_ATTR_OUTPUT_

ENABLED

value: VI_FALSE

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_Commit using the 

following parameter:

vi: The session handle returned from 

niFgen_InitExtCal
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14. Enable the analog output by calling the niFgen Property Node and 

selecting Output»Output Enabled. 

15. Commit the attribute values to the device by calling the niFgen 

Commit VI.

16. Wait 500 ms for the output to settle.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_ReadCalADC 

using the following parameters:

vi: The session handle returned 

from niFgen_InitExtCal

numberOfReadsToAverage: 5

returnCalibratedValue: 

VI_FALSE

calADCValue: A ViReal64 

variable. The variable passed by 

reference through this parameter 

receives the voltage measured 

by the onboard ADC. This value 

is cal ADC measurement 0, 

which is used in step 27.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_SetAttribute

ViBoolean using the following 

parameters:

vi: The session handle returned 

from niFgen_InitExtCal

channelName: NULL

attributeId: 

NIFGEN_ATTR_OUTPUT_

ENABLED

value: VI_TRUE

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_Commit using the 

following parameter:

vi: The session handle returned from 

niFgen_InitExtCal
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17. Use the DMM to measure the NI 5450 differential voltage output. This 

measurement, divided by 2, is external measurement 0, which is used 

in step 27.

18. Configure the DMM according to Configuration 2 in Table 25.

19. Set the main DAC value by calling the niFgen Write Binary 16 Analog 

Static Value VI.

20. Disable the analog output by calling the niFgen Property Node and 

selecting Output»Output Enabled. 

21. Commit the attribute values to the device by calling the niFgen 

Commit VI.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_WriteBinary16

AnalogStaticValue using the 

following parameters:

vi: The session handle returned from 

niFgen_InitExtCal

channelName: NULL

value: 32767

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_SetAttribute

ViBoolean using the following 

parameters:

vi: The session handle returned 

from niFgen_InitExtCal

channelName: NULL

attributeId: 

NIFGEN_ATTR_OUTPUT_

ENABLED

value: VI_FALSE

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_Initialize

FlatnessCalibration using the 

following parameter:

vi: The session handle returned from 

niFgen_InitExtCal
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Note Do not insert any additional settling time between steps 21 and 22.

22. Measure the analog output voltage with the onboard calibration ADC 

by calling the niFgen Read CAL ADC VI. 

23. Enable the analog output by calling the niFgen Property Node and 

selecting Output»Output Enabled. 

 

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_ReadCalADC 

using the following parameters:

vi: The session handle returned 

from niFgen_InitExtCal

numberOfReadsToAverage: 5

returnCalibratedValue: 

VI_FALSE

calADCValue: A ViReal64 

variable. The variable passed by 

reference through this parameter 

receives the voltage measured 

by the onboard ADC. This value 

is cal ADC measurement 1, 

which is used in step 27.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_SetAttribute

ViBoolean using the following 

parameters:

vi: The session handle returned 

from niFgen_InitExtCal

channelName: NULL

attributeId: 

NIFGEN_ATTR_OUTPUT_

ENABLED

value: VI_TRUE
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24. Commit the attribute values to the device by calling the niFgen 

Commit VI.

25. Wait 500 ms for the output to settle.

26. Use the DMM to measure the NI 5450 voltage output. This 

measurement, divided by 2, is external measurement 1, which is used 

in step 27.

27. Call the niFgen Cal Adjust Cal ADC VI.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_Commit using the 

following parameter:

vi: The session handle returned from 

niFgen_InitExtCal

LabVIEW Block Diagram C/C++ Function Call

Call 

niFgen_CalAdjustCalADC 

using the following 

parameters:

vi: The session handle 

returned from 

niFgen_InitExtCal

voltagesMeasured

Externally: An array 

containing two elements: 

The voltages, divided by 2 

(external measurement 0, 

external measurement 1), that 

you measured with the DMM 

in the order they were 

measured.

voltagesMeasuredWith

CalADC: An array containing 

two elements: The 

single-ended voltages 

(cal ADC measurement 0, 

cal ADC measurement 1) 

measured with the onboard 

calibration ADC in the order 

they were measured.
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28. Close the instrument driver session and save the calibration date and 

temperature by calling the niFgen Close Ext Cal VI.

29. Open a session by calling the niFgen Initialize VI.

30. Update gain self-calibration on the onboard EEPROM to use the new 

DC ADC constants by calling the niFgen Self Cal VI.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_CloseExtCal using the 

following parameters:

vi: The session handle returned 

from niFgen_InitExtCal 

action: If the external adjustment 

procedure completed without any errors, 

use NIFGEN_VAL_EXT_CAL_COMMIT. This 

function stores any new calibration 

constants, updated calibration dates, and 

updated calibration temperatures in the 

onboard EEPROM.

If any errors occurred during the external 

adjustment procedure, or if you want to 

abort the operation, use 

NIFGEN_VAL_EXT_CAL_ABORT. This 

function then discards the new calibration 

constants and does not change any 

of the calibration data stored in the onboard 

EEPROM.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_init using the 

following parameters:

vi: The session handle returned 

from niFgen_init.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_SelfCal using the 

following parameters:

vi: The session handle returned 

from niFgen_Init
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31. End the session by calling the niFgen Close VI.

You have finished adjusting the DC ADC reference of the NI 5450. Repeat 

the Verification section to reverify the performance of the NI 5450 after all 

adjustments have been completed.

Adjusting the Frequency Response (Flatness)
Complete the following steps to adjust the frequency response (flatness) 

using a power meter(s) and 7 dB attenuators.

Note Allow the NI 5450 and support equipment to warm up for a minimum of 30 minutes 

prior to performing an adjustment.

1. Connect the power meters to the CH 0 output terminals of the NI 5450 

as shown in Figure 8.

Note If you are using a single power meter, load the unused terminal with the 7 dB 

attenuator and the 50 Ω termination.

2. Configure the power meter as follows:

• Multichannel 

• Average: 128

• Measure watts

• Channel 1 power sensor connected to the NI 5450(+)

• Channel 2 power sensor connected to the NI 5450(–)

• High accuracy

Note Allow 10 seconds for the power meter to stabilize before recording each reading.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_close using the 

following parameter:

vi: The session handle returned from 

niFgen_init
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3. Open a session by calling the niFgen Initialize VI.

4. Prepare the channel for waveform generation by calling the niFgen 

Configure Channels VI.

5. Abort waveform generation by calling the niFgen Abort 

Generation VI.

6. Clear the NI-FGEN memory by calling the niFgen Clear Arbitrary 

Memory VI.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_init using the 

following parameters:

vi: The session handle returned 

from niFgen_init.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_ConfigureChannels 

using the following parameters:

vi: The session handle returned 

from niFgen_InitExtCal.

Channels:

"0" when calibrating CH 0. 

"1" when calibrating CH 1.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_AbortGeneration 

using the following parameter:

vi: The session handle returned from 

niFgen_InitExtCal

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_ClearArbMemory 

using the following parameters:

vi: The session handle returned from 

niFgen_InitExtCal
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7. Set the scaling factor by calling the niFgen Property Node and 

selecting Arbitrary Waveform»Gain.

8. Set the sample rate by calling the niFgen Property Node and selecting 

Clocks»Sample Clock»Rate. 

9. Set the flatness correction factor by calling the niFgen Property Node 

and selecting Output»Filters»Flatness Correction Enabled.

LabVIEW Block Diagram C/C++ Function Call

Call 

niFgen_SetAttribute

ViReal64 using the 

following parameters:

vi: The session handle 

returned from 

niFgen_InitExtCal

attributeId: 

NIFGEN_ATTR_ARB_GAIN

value: 0.5

LabVIEW Block Diagram C/C++ Function Call

Call 

niFgen_SetAttributeViReal

64 using the following parameters:

vi: The session handle returned 

from niFgen_InitExtCal

attributeId: NIFGEN_ATTR_ARB_

SAMPLE_RATE

value: 400,000,000

LabVIEW Block Diagram C/C++ Function Call

Call 

niFgen_SetAttributeViBoolean 

using the following parameters:

vi: The session handle returned from 

niFgen_InitExtCal

attributeId: 

NIFGEN_ATTR_FLATNESS_

CORRECTION_ENABLED

value: VI_FALSE
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10. If you use C function calls, generate a sine wave. If you use LabVIEW, 

configure a waveform by calling the LabVIEW Sine Waveform VI 

with the following inputs:

LabVIEW Block Diagram

• frequency: The Frequency value in Table 26 for the current iteration

• amplitude: 1

• phase: 0

• resetSignal: VI_TRUE

• offset: 0.0

• samplingInfo: A cluster of two elements: Sampling rate of 400,000,000 and the Number of 

Samples value in Table 26 for the current iteration.
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11. Create an onboard waveform by calling the niFgen Create 

Waveform (WDT) instance of the niFgen Create Waveform (poly) VI.

12. Initiate waveform generation by calling the niFgen Initiate 

Generation VI.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_Create

WaveformF64 using the 

following parameters:

vi: The session handle 

returned from 

niFgen_InitExtCal

waveform: The signal out 

returned from the Sine 

Waveform VI in step 10.

waveformSize: Value from 

Table 26.

waveformDataArray: 

Array of sine waveform 

data.

waveformHandle: A 

pointer to a waveform. 

The variable passed by 

reference through this 

parameter acts as a handle 

to the waveform and can be 

used for setting the active 

waveform, changing the 

data in the waveform, 

building sequences of 

waveforms, or deleting the 

waveform when it is no 

longer needed.

LabVIEW Block Diagram C/C++ Function Call

Call 

niFgen_InitiateGeneration 

using the following parameter:

vi: The session handle returned from 

niFgen_InitExtCal
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13. Record the readings from the power meters.

14. Repeat steps 5 through 13 for each frequency listed in Table 26.

Note If you are using a single power meter, load the unused terminal with the 7 dB 

attenuator and the 50 Ω termination.

15. Convert the power measurements from watts to volts by taking the 

square root.

16. Add the positive terminal voltage and the negative terminal voltage 

measurements for each frequency in Table 26 to obtain the differential 

voltage result.

17. Remove the DAC sinc response by dividing each differential voltage 

result by .

where:

18. Make measurements relative to the 50 kHz result by dividing each 

differential voltage result by the differential voltage measured with a 

waveform frequency of 50 kHz.

Table 26.  Frequencies and Samples for Adjusting 

Sine Wave Flatness Correction

Frequencies Samples

50 kHz, Reference 16,000

10 MHz 800,000

20 MHz 400,000

30 MHz 400,000

40 MHz 200,000

50 MHz 160,000

60 MHz 200,000

70 MHz 400,000

80 MHz 100,000

90 MHz 1,600,000

100 MHz 80,000

x( ) x⁄sin

x
OutputFrequency π×

400 000 000, ,
---------------------------------------------------------- 
 =
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19. End the session by calling the niFgen Close VI.

20. Connect the power meters to the CH 1 output terminals of the NI 5450 

as shown in Figure 9.

21. Repeat steps 3 through 19 for CH 1.

110 MHz 1,200,000

120 MHz 100,000

130 MHz 400,000

140 MHz 200,000

150 MHz 80,000

160 MHz 50,000

170 MHz 800,000

180 MHz 800,000

190 MHz 400,000

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_close using the 

following parameter:

vi: The session handle returned from 

niFgen_init

Table 26.  Frequencies and Samples for Adjusting 
Sine Wave Flatness Correction (Continued)

Frequencies Samples
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22. Open an NI-FGEN external calibration session by calling the niFgen 

Init Ext Cal VI.

23. Initialize flatness calibration by calling the niFgen Initialize Flatness 

Calibration VI.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_InitExtCal using the 

following parameters:

resourceName: The name of the device 

you want to calibrate. This name can be 

found under Devices and Interfaces in 

MAX.

password: The password required to 

open an external calibration session. 

The default password is “NI”.

vi: A pointer to an IVI session. The 

variable passed by reference through 

this parameter receives the value that 

identifies the external calibration 

session created by this function. This 

value acts as the session handle and is 

passed as the first parameter to all 

subsequent NI-FGEN functions.

LabVIEW Block Diagram C/C++ Function Call

Call 

niFgen_InitializeFlatness

Calibration using the following 

parameter:

vi: The session handle returned from 

niFgen_InitExtCal
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24. Adjust the onboard calibration constants by calling the niFgen Cal 

Adjust Flatness VI.

25. Adjust the onboard calibration constants by calling the niFgen Cal 

Adjust Flatness VI.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_CalAdjust

Flatness using the following 

parameters:

vi: The session handle returned 

from niFgen_InitExtCal

channelName: "0"

requestedAmplitude: 1

configuration: 

NIFGEN_VAL_CAL_CONFIG_

DIRECT_PATH

frequenciesArray: An array of 

the frequencies from Table 26, 

including the 50 kHz 

Reference.

measuredAmplitudesArray: 

An array of the amplitudes 

calculated in step 18 for CH 0.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_CalAdjust

Flatness using the following 

parameters:

vi: The session handle returned 

from niFgen_InitExtCal

channelName: "1"

requestedAmplitude: 1

configuration: 

NIFGEN_VAL_CAL_CONFIG_

DIRECT_PATH

frequenciesArray: An array of 

the frequencies from Table 26, 

including the 50 kHz 

Reference.

measuredAmplitudesArray: 

An array of the amplitudes 

calculated in step 18 for CH 1.
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26. Close the instrument driver session and save the calibration date and 

temperature by calling the niFgen Close Ext Cal VI.

You have finished adjusting the frequency response (flatness) of the 

NI 5450. Repeat the Verification section to reverify the performance of 

the NI 5450 after adjustments.

LabVIEW Block Diagram C/C++ Function Call

Call niFgen_CloseExtCal using the 

following parameters:

vi: The session handle returned 

from niFgen_InitExtCal 

action: If the external adjustment 

procedure completed without any errors, 

use NIFGEN_VAL_EXT_CAL_COMMIT. This 

function stores any new calibration 

constants, updated calibration dates, and 

updated calibration temperatures in the 

onboard EEPROM. 

If any errors occurred during the external 

adjustment procedure, or if you want to 

abort the operation, use 

NIFGEN_VAL_EXT_CAL_ABORT. This 

function then discards the new calibration 

constants and does not change any 

of the calibration data stored in the onboard 

EEPROM.
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Verification Records

This section includes the verification limits for the following 

specifications: 

• DC Voltage Absolute Accuracy

• DC Voltage Amplitude Channel-to-Channel Relative Accuracy

• DC Voltage Differential Offset

• DC Voltage Common Mode Offset

• AC Voltage Amplitude Absolute Accuracy

• AC Amplitude Channel-to-Channel Relative Accuracy

• Channel-to-Channel Timing Alignment Accuracy

• AC Voltage Amplitude Frequency Response (Flatness) Accuracy

• Average Noise Density

• Internal Reference Clock Frequency Accuracy

Compare these limits to the results you obtain in the Verification section.

Note Limits in the following tables are based upon the March 2009 edition of the NI 5450 

Specifications. Refer to the most recent NI 5450 specifications online at ni.com/

manuals. If a more recent edition of the specifications is available, recalculate the limits 

based upon the latest specifications.

Note Measurement uncertainty was calculated in accordance with the method described 

in ISO GUM (Guide to the Expression of Uncertainty in Measurement), for a confidence 

level of 95%. The expressed uncertainty is based in the recommended measurement 

methodology, standards, metrology best practices and environmental conditions of the 

National Instruments laboratory. It should be considered as a guideline for the level of 

measurement uncertainty that can be achieved using the recommended method, but it is not 

a replacement for the user uncertainty analysis that takes in consideration user’s conditions 

and practices.
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Table 27.  NI 5450 DC Voltage Amplitude Absolute Accuracy Verification Limits

CH Range Output

Negative As 

Found Test 

Limit

Negative After 

Adjustment 

Test Limit

Measured 

Value

Positive As 

Found Test 

Limit

Positive After 

Adjustment 

Test Limit

Measurement 

Uncertainty

0 2 V +0.1 V –0.004 –0.0018 +0.004 +0.0018

0 2 V +0.5 V –0.004 –0.0018 +0.004 +0.0018

0 2 V +1.0 V –0.004 –0.0018 +0.004 +0.0018

0 2 V –0.1 V –0.004 –0.0018 +0.004 +0.0018

0 2 V –0.5 V –0.004 –0.0018 +0.004 +0.0018

0 2 V –1.0 V –0.004 –0.0018 +0.004 +0.0018

1 2 V +0.1 V –0.004 –0.0018 +0.004 +0.0018

1 2 V +0.5 V –0.004 –0.0018 +0.004 +0.0018

1 2 V +1.0 V –0.004 –0.0018 +0.004 +0.0018

1 2 V –0.1 V –0.004 –0.0018 +0.004 +0.0018

1 2 V –0.5 V –0.004 –0.0018 +0.004 +0.0018

1 2 V –1.0 V –0.004 –0.0018 +0.004 +0.0018
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Table 28.  NI 5450 DC Voltage Differential Offset Accuracy Verification Limits

CH Range Output

Negative 

As Found 

Test Limit

Negative 

After 

Adjustment 

Test Limit

Measured 

Value

Positive 

As Found 

Test 

Limit

Positive 

After 

Adjustment 

Test Limit

Measurement 

Uncertainty

0 2 V 0.0 V –1.000 0 

mV

–0.7500 mV +1.000 0 

mV

+0.7500 mV

1 2 V 0.0 V –1.000 0 

mV

–0.7500 mV +1.000 0 

mV

+0.7500 mV

Table 29.  DC Voltage Common Mode Offset Accuracy

CH Range Output

Negative 

As Found 

Test Limit

Negative 

After 

Adjustment 

Test Limit

Calculated 

Value

Positive 

As Found 

Test 

Limit

Positive 

After 

Adjustment 

Test Limit

Measurement 

Uncertainty

0 2 V 0.0 V –350.000 

µV

–250.000 

µV

+350.000 

µV

+250.000 µV

1 2 V 0.0 V –350.000 

µV

–250.000 

µV

+350.000 

µV

+250.000 µV

Table 30.  NI 5450 DC Voltage Amplitude Channel-to-Channel Relative Accuracy Verification Limits

CH Range Setting

Negative Test 

Limit

Calculated 

Value

Positive Test 

Limit

Measurement 

Uncertainty

0, 1 2 V 0.1 V –1600 µV ε0,1= +1600 µV

0, 1 2 V –0.1 V –1600 µV ε0,1= +1600 µV

0, 1 2 V 0.5 V –1600 µV ε0,1= +1600 µV

0, 1 2 V –0.5 V –1600 µV ε0,1= +1600 µV

0, 1 2 V 1.0 V –1600 µV ε0,1= +1600 µV

0, 1 2 V –1.0 V –1600 µV ε0,1= +1600 µV

εVCMO

VCMO +( ) VCMO -( )+( )

2
----------------------------------------------------=

ε 0 1,( ) VCH0 VCH1–=
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Table 31.  NI 5450 AC Voltage Amplitude Absolute Accuracy Verification Limits

CH Differential Range Frequency

Negative As 

Found Test 

Limit

Negative After 

Adjustment 

Test Limit

Calculated 

Value

Positive As 

Found Test 

Limit

Positive After 

Adjustment 

Test Limit

Measurement 

Uncertainty

0 2.0 V 50 kHz –0.5% –0.2% ε = +0.5% +0.2%

1 2.0 V 50 kHz –0.5% –0.2% ε = +0.5% +0.2%

ε 2 VRMS× 1–( ) 100×=



© National Instruments Corporation 79 NI 5450 Calibration Procedure

Table 32.  NI 5450 AC Amplitude Channel-to-Channel Relative Accuracy Verification Limits

CH

Differential 

Range Frequency

Negative Test 

Limit

Calculated 

Value

Positive Test 

Limit

Measurement 

Uncertainty

0, 1 2.0 V 50 kHz –4.0 mV ε0,1= +4.0 mV

Table 33.  NI 5450 Channel-to-Channel Timing Alignment Accuracy Verification Limits

CH Amplitude Frequency

Negative Test 

Limit

Calculated 

Value

Positive Test 

Limit

Measurement 

Uncertainty

0, 1 0 dBFS 10 MHz 0 ps talign= 35 ps

ε0,1 2 2 VRMSCH0
VRMSCH1

–( )××=

talignment tCH2 tCH 1( )–=
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Table 34.  NI 5450 AC Voltage Amplitude Frequency Response (Flatness) Accuracy Verification Limits

CH Amplitude Frequency

Negative As 

Found Test 

Limit

Negative 

After 

Adjustment 

Test Limit Calculated Value

Positive As 

Found Test 

Limit

Positive 

After 

Adjustment 

Test Limit

Measurement 

Uncertainty

0 0 dBFS 50 kHz Reference R(+)50 = _________ R(–)50 = _________

0 0 dBFS 10 kHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 0 dBFS 100 kHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 0 dBFS 1 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 0 dBFS 10 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 0 dBFS 20 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 0 dBFS 30 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 0 dBFS 40 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 0 dBFS 50 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 0 dBFS 60 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 0 dBFS 70 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

0 0 dBFS 80 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

0 0 dBFS 90 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

0 0 dBFS 100 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

0 0 dBFS 110 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

0 0 dBFS 120 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

1 0 dBFS 50 kHz Reference R(+)50 = _________ R(–)50 = _________

FlatnessRef 10
Wf +( ) W+

f -( )
2 Wf +( ) Wf -( )

××+

WRef +( ) W+
Ref -( )

2 WRef +( )
WRef -( )

××+
-------------------------------------------------------------------------------------------------------log×=
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1 0 dBFS 10 kHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 0 dBFS 100 kHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 0 dBFS 1 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 0 dBFS 10 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 0 dBFS 20 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 0 dBFS 30 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 0 dBFS 40 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 0 dBFS 50 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 0 dBFS 60 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 0 dBFS 70 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

1 0 dBFS 80 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

1 0 dBFS 90 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

1 0 dBFS 100 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

1 0 dBFS 110 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

1 0 dBFS 120 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

0 –20 dBFS 50 kHz Reference R(+)50 = _________ R(–)50 = _________

0 –20 dBFS 10 kHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 –20 dBFS 100 kHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 –20 dBFS 1 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 –20 dBFS 10 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

Table 34.  NI 5450 AC Voltage Amplitude Frequency Response (Flatness) Accuracy Verification Limits (Continued)

CH Amplitude Frequency

Negative As 

Found Test 

Limit

Negative 

After 

Adjustment 

Test Limit Calculated Value

Positive As 

Found Test 

Limit

Positive 

After 

Adjustment 

Test Limit

Measurement 

Uncertainty
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0 –20 dBFS 20 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 –20 dBFS 30 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 –20 dBFS 40 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 –20 dBFS 50 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 –20 dBFS 60 MHz –0.24 dB –0.22 dB Flatnessch0(f)= +0.24 dB +0.22 dB

0 –20 dBFS 70 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

0 –20 dBFS 80 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

0 –20 dBFS 90 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

0 –20 dBFS 100 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

0 –20 dBFS 110 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

0 –20 dBFS 120 MHz –0.34 dB –0.25 dB Flatnessch0(f)= +0.34 dB +0.25 dB

1 –20 dBFS 50 kHz Reference R(+)50 = _________ R(–)50 = _________

1 –20 dBFS 10 kHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 –20 dBFS 100 kHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 –20 dBFS 1 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 –20 dBFS 10 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 –20 dBFS 20 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 –20 dBFS 30 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 –20 dBFS 40 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 –20 dBFS 50 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

Table 34.  NI 5450 AC Voltage Amplitude Frequency Response (Flatness) Accuracy Verification Limits (Continued)

CH Amplitude Frequency

Negative As 

Found Test 

Limit

Negative 

After 

Adjustment 

Test Limit Calculated Value

Positive As 

Found Test 

Limit

Positive 

After 

Adjustment 

Test Limit

Measurement 

Uncertainty
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1 –20 dBFS 60 MHz –0.24 dB –0.22 dB Flatnessch1(f)= +0.24 dB +0.22 dB

1 –20 dBFS 70 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

1 –20 dBFS 80 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

1 –20 dBFS 90 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

1 –20 dBFS 100 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

1 –20 dBFS 110 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

1 –20 dBFS 120 MHz –0.34 dB –0.25 dB Flatnessch1(f)= +0.34 dB +0.25 dB

Table 34.  NI 5450 AC Voltage Amplitude Frequency Response (Flatness) Accuracy Verification Limits (Continued)

CH Amplitude Frequency

Negative As 

Found Test 

Limit

Negative 

After 

Adjustment 

Test Limit Calculated Value

Positive As 

Found Test 

Limit

Positive 

After 

Adjustment 

Test Limit

Measurement 

Uncertainty
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Table 35.  NI 5450 Average Noise Density Verification Limits

CH Amplitude Frequency Measured Value

Positive Test 

Limit

Measurement 

Uncertainty

0 –40 dBFS 1 MHz NoiseDensity

(10 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(20 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(30 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(40 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(50 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(60 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(70 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(80 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(90 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(100 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(110 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(120 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(130 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(140 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(150 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(160 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(170 MHz)=____________dBm/Hz

–160 dBm/Hz

AVG_ND 20
10

log×
Σ

n
i 1= 10

NoiseDensity i( )

20
-------------------------------------------- 

n
-----------------------------------------------------------
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
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

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0 –40 dBFS 1 MHz NoiseDensity

(180 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(190 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz NoiseDensity

(200 MHz)=____________dBm/Hz

–160 dBm/Hz

0 –40 dBFS 1 MHz AVG_NDCH0=______________dBm/Hz –160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(10 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(20 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(30 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(40 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(50 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(60 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(70 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(80 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(90 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(100 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(110 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(120 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(130 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(140 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(150 MHz)=____________dBm/Hz

–160 dBm/Hz

Table 35.  NI 5450 Average Noise Density Verification Limits (Continued)

CH Amplitude Frequency Measured Value

Positive Test 

Limit

Measurement 

Uncertainty
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1 –40 dBFS 1 MHz NoiseDensity

(160 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(170 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(180 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(190 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz NoiseDensity

(200 MHz)=____________dBm/Hz

–160 dBm/Hz

1 –40 dBFS 1 MHz AVG_NDCH1=____________dBm/Hz –160 dBm/Hz

Table 35.  NI 5450 Average Noise Density Verification Limits (Continued)

CH Amplitude Frequency Measured Value

Positive Test 

Limit

Measurement 

Uncertainty
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Table 36.  NI 5450 Internal Reference Clock Frequency Accuracy Verification Limits

CH Amplitude Frequency

Negative As 

Found Test Limit Calculated Value Positive Test Limit

Measurement 

Uncertainty

00 0 dBFS 10 MHz –0.01% ε= +0.01%

ε
fmeas 10M–

10 M
----------------------------- 100×=
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Optional Verification Limits

This section includes the verification limits for the following 

specifications:

• Channel-to-Channel Frequency Response (Flatness) Matching 

Accuracy

• Analog Bandwidth

• Spurious Free Dynamic Range (SFDR) with Harmonics Accuracy

• Spurious Free Dynamic Range without Harmonics Accuracy

• Total Harmonic Distortion (THD)

• Intermodulation Distortion (IMD3)

• Rise/Fall Time

• Phase Noise Density

• Jitter 

Compare these limits to the results you obtain in the Verification section.

Table 37.  NI 5450 Channel-to-Channel Frequency Response (Flatness) Matching Accuracy Verification Limits

Amplitude Frequency

Negative Test 

Limit, Typical Calculated Value (dB)

Positive Test 

Limit, Typical

0 dBFS 10 kHz –0.03 dB ε(CH0–CH1)= +0.03 dB

0 dBFS 100 kHz –0.03 dB ε(CH0–CH1)= +0.03 dB

0 dBFS 1 MHz –0.03 dB ε(CH0–CH1)= +0.03 dB

0 dBFS 10 MHz –0.03 dB ε(CH0–CH1)= +0.03 dB

0 dBFS 20 MHz –0.03 dB ε(CH0–CH1)= +0.03 dB

0 dBFS 30 MHz –0.03 dB ε(CH0–CH1)= +0.03 dB

0 dBFS 40 MHz –0.03 dB ε(CH0–CH1)= +0.03 dB

0 dBFS 50 MHz –0.03 dB ε(CH0–CH1)= +0.03 dB

0 dBFS 60 MHz –0.03 dB ε(CH0–CH1)= +0.03 dB

0 dBFS 70 MHz –0.04 dB ε(CH0–CH1)= +0.04 dB

0 dBFS 80 MHz –0.04 dB ε(CH0–CH1)= +0.04 dB

0 dBFS 90 MHz –0.04 dB ε(CH0–CH1)= +0.04 dB

0 dBFS 100 MHz –0.04 dB ε(CH0–CH1)= +0.04 dB

ε CH0 CH1–( ) FlatnessCH0 f( ) FlatnessCH1 f( )–=
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0 dBFS 110 MHz –0.04 dB ε(CH0–CH1)= +0.04 dB

0 dBFS 120 MHz –0.04 dB ε(CH0–CH1)= +0.04 dB

Table 38.  NI 5450 Analog Bandwidth Verification Limits

CH Amplitude Frequency Calculate Value (dB)

Test Limit, 

Typical

0 –1 dBFS 50 kHz Reference= —

0 –1 dBFS 130 MHz Flatness= ≥ –2.25 dB

0 –1 dBFS 140 MHz Flatness= ≥ –2.75 dB

0 –1 dBFS 145 MHz Flatness= ≥ –3 dB

1 –1 dBFS 50 kHz Reference= —

1 –1 dBFS 130 MHz Flatness= ≥ –2.25 dB

1 –1 dBFS 140 MHz Flatness= ≥ –2.75 dB

1 –1 dBFS 145 MHz Flatness= ≥ –3 dB

Table 39.  NI 5450 Spurious Free Dynamic Range with Harmonics Accuracy Verification Limits

CH Amplitude Frequency Calculated Value (dB)

Test Limit, 

Typical

SFDRWith Harmonics = Ampl(carrier)–Ampl(LargeSpur)

0 –1 dBFS 10 MHz SFDRWith Harmonics= ≥70 dB

0 –1 dBFS 60 MHz SFDRWith Harmonics= ≥68 dB

0 –1 dBFS 100 MHz SFDRWith Harmonics= ≥62 dB

0 –1 dBFS 120 MHz SFDRWith Harmonics= ≥62 dB

0 –1 dBFS 160 MHz SFDRWith Harmonics= ≥62 dB

1 –1 dBFS 10 MHz SFDRWith Harmonics= ≥70 dB

Table 37.  NI 5450 Channel-to-Channel Frequency Response (Flatness) Matching Accuracy Verification Limits 

Amplitude Frequency

Negative Test 

Limit, Typical Calculated Value (dB)

Positive Test 

Limit, Typical

FlatnessRef 10
Wf +( ) W+

f -( )
2 Wf +( ) Wf -( )

××+

WRef +( ) W+
Ref -( )

2 WRef +( )
WRef -( )

××+
-------------------------------------------------------------------------------------------------------log×=
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1 –1 dBFS 60 MHz SFDRWith Harmonics= ≥68 dB

1 –1 dBFS 100 MHz SFDRWith Harmonics= ≥62 dB

1 –1 dBFS 120 MHz SFDRWith Harmonics= ≥62 dB

1 –1 dBFS 160 MHz SFDRWith Harmonics= ≥62 dB

Table 40.  NI 5450 Spurious Free Dynamic Range without Harmonics Accuracy Verification Limits

CH Amplitude Frequency Calculated Value (dB) Test Limit, Typical

SFDRWithout Harmonics=

Ampl(carrier) – Ampl(Non–Harmonic LargeSpur)

0 –1 dBFS 10 MHz SFDRWithout Harmonics= ≥70 dB

0 –1 dBFS 60 MHz SFDRWithout Harmonics= ≥68 dB

0 –1 dBFS 100 MHz SFDRWithout Harmonics= ≥64 dB

0 –1 dBFS 120 MHz SFDRWithout Harmonics= ≥62 dB

0 –1 dBFS 160 MHz SFDRWithout Harmonics= ≥62 dB

1 –1 dBFS 10 MHz SFDRWithout Harmonics= ≥70 dB

1 –1 dBFS 60 MHz SFDRWithout Harmonics= ≥68 dB

1 –1 dBFS 100 MHz SFDRWithout Harmonics= ≥64 dB

1 –1 dBFS 120 MHz SFDRWithout Harmonics= ≥62 dB

1 –1 dBFS 160 MHz SFDRWithout Harmonics= ≥62 dB

Table 41.  NI 5450 Total Harmonic Distortion (THD) Verification Limits

CH Amplitude Frequency Measured Value (dBc)

Test Limit, 

Typical

0 –1 dBFS 10.1 MHz THD = ≤–75 dBc

0 –1 dBFS 20.1 MHz THD = ≤–70 dBc

0 –1 dBFS 40.1 MHz THD = ≤–68 dBc

0 –1 dBFS 80.1 MHz THD = ≤–68 dBc

0 –1 dBFS 100.1 MHz THD = ≤–68 dBc

Table 39.  NI 5450 Spurious Free Dynamic Range with Harmonics Accuracy Verification Limits (Continued)

CH Amplitude Frequency Calculated Value (dB)

Test Limit, 

Typical
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0 –1 dBFS 120.1 MHz THD = ≤–78 dBc

0 –1 dBFS 160.1 MHz THD = ≤–83 dBc

1 –1 dBFS 10.1 MHz THD = ≤–75 dBc

1 –1 dBFS 20.1 MHz THD = ≤–70 dBc

1 –1 dBFS 40.1 MHz THD = ≤–68 dBc

1 –1 dBFS 80.1 MHz THD = ≤–68 dBc

1 –1 dBFS 100.1 MHz THD = ≤–68 dBc

1 –1 dBFS 120.1 MHz THD = ≤–78 dBc

1 –1 dBFS 160.1 MHz THD = ≤–83 dBc

Table 42.  NI 5450 Intermodulation Distortion (IMD3) Verification Limits

CH Amplitude Frequency Calculated Value (dBC)

Test Limit,

Typical

0 –7 dBFS 10 MHz IMD3= ≤–84 dBc

0 –7 dBFS 20 MHz IMD3= ≤–81 dBc

0 –7 dBFS 40 MHz IMD3= ≤–75 dBc

0 –7 dBFS 60 MHz IMD3= ≤–71 dBc

0 –7 dBFS 80 MHz IMD3= ≤–68 dBc

0 –7 dBFS 120 MHz IMD3= ≤–68 dBc

0 –7 dBFS 160 MHz IMD3= ≤–66 dBc

1 –7 dBFS 10 MHz IMD3= ≤–84 dBc

1 –7 dBFS 20 MHz IMD3= ≤–81 dBc

1 –7 dBFS 40 MHz IMD3= ≤–75 dBc

1 –7 dBFS 60 MHz IMD3= ≤–71 dBc

1 –7 dBFS 80 MHz IMD3= ≤–68 dBc

Table 41.  NI 5450 Total Harmonic Distortion (THD) Verification Limits (Continued)

CH Amplitude Frequency Measured Value (dBc)

Test Limit, 

Typical

Max P 2 f2 f1–×  P 2 f1 f2–× ( , ) Min Pf1
Pf2

( , )–
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1 –7 dBFS 120 MHz IMD3 = ≤–68 dBc

1 –7 dBFS 160 MHz IMD3 = ≤–66 dBc

Table 43.  NI 5450 Rise and Fall Time Verification Limits

CH Amplitude Frequency Measured Value

Test Limit, 

Typical

0+ 330 mVpk–pk 33 MHz Rise time =            ns ≤3 ns

0+ 330 mVpk–pk 33 MHz Fall time =            ns ≤3 ns

0+ 330 mVpk–pk 33 MHz Rising Edge Aberration =        % ≤7%

0+ 330 mVpk–pk 33 MHz Falling Edge Aberration =        % ≤7%

0- 330 mVpk–pk 33 MHz Rise time =            ns ≤3 ns

0- 330 mVpk–pk 33 MHz Fall time =            ns ≤3 ns

0- 330 mVpk–pk 33 MHz Rising Edge Aberration =        % ≤7%

0- 330 mVpk–pk 33 MHz Falling Edge Aberration =        % ≤7%

1+ 330 mVpk–pk 33 MHz Rise time =            ns ≤3 ns

1+ 330 mVpk–pk 33 MHz Fall time =            ns ≤3 ns

1+ 330 mVpk–pk 33 MHz Rising Edge Aberration =        % ≤7%

1+ 330 mVpk–pk 33 MHz Falling Edge Aberration =        % ≤7%

1- 330 mVpk–pk 33 MHz Rise time =            ns ≤3 ns

1- 330 mVpk–pk 33 MHz Fall time =            ns ≤3 ns

1- 330 mVpk–pk 33 MHz Rising Edge Aberration =        % ≤7%

1- 330 mVpk–pk 33 MHz Falling Edge Aberration =        % ≤7%

Table 42.  NI 5450 Intermodulation Distortion (IMD3) Verification Limits (Continued)

CH Amplitude Frequency Calculated Value (dBC)

Test Limit,

Typical
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Table 44.  NI 5450 Phase Noise Density and Jitter Verification Limits

CH Amplitude Frequency Measured Value

Test Limit, 

Typical

0 0 dBFS 10 MHz PND [100 Hz] =            dBc/Hz ≤–121 dBc/Hz

0 0 dBFS 10 MHz PND [1 kHz]   =            dBc/Hz ≤–137 dBc/Hz

0 0 dBFS 10 MHz PND [10 kHz]   =            dBc/Hz ≤–146 dBc/Hz

0 0 dBFS 10 MHz PND [100 kHz] =            dBc/Hz ≤–152 dBc/Hz

0 0 dBFS 10 MHz PND [1 MHz]   =            dBc/Hz ≤–153 dBc/Hz

0 0 dBFS 10 MHz Jitter [100 Hz–100 kHz] =        fs ≤350 fs

0 0 dBFS 100 MHz PND [100 Hz] =            dBc/Hz ≤–101 dBc/Hz

0 0 dBFS 100 MHz PND [1 kHz]   =            dBc/Hz ≤–119 dBc/Hz

0 0 dBFS 100 MHz PND [10 kHz]   =            dBc/Hz ≤–126 dBc/Hz

0 0 dBFS 100 MHz PND [100 kHz] =            dBc/Hz ≤–136 dBc/Hz

0 0 dBFS 100 MHz PND [1 MHz]   =            dBc/Hz ≤–141 dBc/Hz

0 0 dBFS 100 MHz Jitter [100 Hz–100 kHz] =        fs ≤350 fs

1 0 dBFS 10 MHz PND [100 Hz] =            dBc/Hz ≤–121 dBc/Hz

1 0 dBFS 10 MHz PND [1 kHz]   =            dBc/Hz ≤–137 dBc/Hz

1 0 dBFS 10 MHz PND [10 kHz]   =            dBc/Hz ≤–146 dBc/Hz

1 0 dBFS 10 MHz PND [100 kHz] =            dBc/Hz ≤–152 dBc/Hz

1 0 dBFS 10 MHz PND [1 MHz]   =            dBc/Hz ≤–153 dBc/Hz

1 0 dBFS 10 MHz Jitter [100 Hz–100 kHz] =        fs ≤350 fs

1 0 dBFS 100 MHz PND [100 Hz] =            dBc/Hz ≤–101 dBc/Hz

1 0 dBFS 100 MHz PND [1 kHz]   =            dBc/Hz ≤–119 dBc/Hz

1 0 dBFS 100 MHz PND [10 kHz]   =            dBc/Hz ≤–126 dBc/Hz

1 0 dBFS 100 MHz PND [100 kHz] =            dBc/Hz ≤–136 dBc/Hz

1 0 dBFS 100 MHz PND [1 MHz]   =            dBc/Hz ≤–141 dBc/Hz

1 0 dBFS 100 MHz Jitter [100 Hz–100 kHz] =        fs ≤350 fs
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Where to Go for Support

The National Instruments Web site is your complete resource for technical 

support. At ni.com/support you have access to everything from 

troubleshooting and application development self-help resources to email 

and phone assistance from NI Application Engineers.

A Declaration of Conformity (DoC) is our claim of compliance with the 

Council of the European Communities using the manufacturer’s 

declaration of conformity. This system affords the user protection for 

electromagnetic compatibility (EMC) and product safety. You can obtain 

the DoC for your product by visiting ni.com/certification. If your 

product supports calibration, you can obtain the calibration certificate for 

your product at ni.com/calibration.

National Instruments corporate headquarters is located at 

11500 North Mopac Expressway, Austin, Texas, 78759-3504. 

National Instruments also has offices located around the world to help 

address your support needs. For telephone support in the United States, 

create your service request at ni.com/support and follow the calling 

instructions or dial 512 795 8248. For telephone support outside the United 

States, contact your local branch office: 

Australia 1800 300 800, Austria 43 662 457990-0, 

Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599, 

Canada 800 433 3488, China 86 21 5050 9800, 

Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, 

Finland 358 (0) 9 725 72511, France 01 57 66 24 24, 

Germany 49 89 7413130, India 91 80 41190000, Israel 972 3 6393737, 

Italy 39 02 41309277, Japan 0120-527196, Korea 82 02 3451 3400, 

Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710, 

Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466, 

New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60, 

Poland 48 22 328 90 10, Portugal 351 210 311 210, 

Russia 7 495 783 6851, Singapore 1800 226 5886, 

Slovenia 386 3 425 42 00, South Africa 27 0 11 805 8197, 

Spain 34 91 640 0085, Sweden 46 (0) 8 587 895 00, 

Switzerland 41 56 2005151, Taiwan 886 02 2377 2222, 

Thailand 662 278 6777, Turkey 90 212 279 3031, 

United Kingdom 44 (0) 1635 523545
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